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Accuracy 

While reasonable efforts have been made to assure the accuracy of this document, Cambium 

Networks assumes no liability resulting from any inaccuracies or omissions in this document, or 

from use of the information obtained herein. Cambium reserves the right to make changes to 

any products described herein to improve reliability, function, or design, and reserves the right 

to revise this document and to make changes from time to time in content hereof with no 
obligation to notify any person of revisions or changes. Cambium does not assume any liability 

arising out of the application or use of any product, software, or circuit described herein; neither 
does it convey license under its patent rights or the rights of others. It is possible that this 

publication may contain references to, or information about Cambium products (machines and 

programs), programming, or services that are not announced in your country. Such references 
or information must not be construed to mean that Cambium intends to announce such 

Cambium products, programming or services in your country. 

Copyrights 

This document, Cambium products, and 3rd Party software products described in this document 

may include or describe copyrighted Cambium and other 3rd Party supplied computer programs 

stored in semiconductor memories or other media. Laws in the United States and other 

countries preserve for Cambium, its licensors, and other 3rd Party supplied software certain 

exclusive rights for copyrighted material, including the exclusive right to copy, reproduce in any 

form, distribute and make derivative works of the copyrighted material. Accordingly, any 

copyrighted material of Cambium, its licensors, or the 3rd Party software supplied material 

contained in the Cambium products described in this document may not be copied, reproduced, 

reverse engineered, distributed, merged or modified in any manner without the express written 
permission of Cambium. Furthermore, the purchase of Cambium products shall not be deemed 

to grant either directly or by implication, estoppel, or otherwise, any license under the 
copyrights, patents or patent applications of Cambium or other 3rd Party supplied software, 

except for the normal non-exclusive, royalty free license to use that arises by operation of law in 

the sale of a product. 

Restrictions 

Software and documentation are copyrighted materials. Making unauthorized copies is 

prohibited by law. No part of the software or documentation may be reproduced, transmitted, 

transcribed, stored in a retrieval system, or translated into any language or computer language, 

in any form or by any means, without prior written permission of Cambium. 

License Agreements 

The software described in this document is the property of Cambium and its licensors. It is 
furnished by express license agreement only and may be used only in accordance with the 

terms of such an agreement. 

High Risk Materials 

Cambium and its supplier(s) specifically disclaim any express or implied warranty of fitness for 
any high risk activities or uses of its products including, but not limited to, the operation of 

nuclear facilities, aircraft navigation or aircraft communication systems, air traffic control, life 

support, or weapons systems (“High Risk Use”). Any High Risk is unauthorized, is made at your 

own risk and you shall be responsible for any and all losses, damage or claims arising out of any 
High Risk Use. 

© 2016 Cambium Networks Limited. All Rights Reserved. 
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Safety and Regulatory Information 
 

This section describes important safety and regulatory guidelines that must be observed by 

personnel installing or operating cnPilot Enterprise AP equipment. 

Important Safety Information 

To prevent loss of life or physical injury, observe the safety guidelines in this section. 

Power lines 

Exercise extreme care when working near power lines. 

Working at heights 

Exercise extreme care when working at heights. 

Grounding and protective earth 

cnPilot Enterprise AP devices must be properly grounded to protect against lightning. It is the 

user’s responsibility to install the equipment in accordance with national regulations. In the USA, 

follow Section 810 of the National Electric Code, ANSI/NFPA No.70-1984 (USA). In Canada, follow 

Section 54 of the Canadian Electrical Code. These codes describe correct installation procedures 

for grounding the outdoor unit, mast, lead-in wire and discharge unit, size of grounding 

conductors and connection requirements for grounding electrodes. Other regulations may apply in 

different countries and therefore it is recommended that installation be contracted to a 

professional installer. 

Powering down before servicing 

Always power down and unplug the equipment before servicing. 

Primary disconnect device 

The cnPilot Enterprise AP power supply is the primary disconnect device. 

RF exposure near the antenna 

Strong radio frequency (RF) fields will be present close to the antenna when the transmitter is on. 

Always turn off the power to the cnPilot Enterprise AP device before undertaking maintenance 

activities in front of the antenna. 

Important Regulatory Information 
The cnPilot Enterprise AP product is certified as an unlicensed device in frequency bands where it 

is not allowed to cause interference to licensed services (called primary users of the bands). 

Radar avoidance 

In countries where radar systems are the primary band users, the regulators have mandated 

special requirements to protect these systems from interference caused by unlicensed devices. 

Unlicensed devices must detect and avoid co-channel operation with radar systems. 
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The cnPilot Enterprise AP detects and avoids functionality for countries and frequency bands 

requiring protection for radar systems. The cnPilot Enterprise AP is qualified for ETSI/FCC DFS 

certification for radar detection and avoidance as per the law. 

Installers and users must meet all local regulatory requirements for radar detection. To meet these 

requirements, users must set the correct country code during commissioning of the cnPilot 

Enterprise AP equipment. If this is not done, installers and users may be liable to civil and criminal 

penalties. 

Contact the Cambium helpdesk if more guidance is required. 

USA and Canada Specific Information 
 

Federal Communication Commission Interference Statement 

 
This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 

off and on, the user is encouraged to try to correct the interference by one of the following 

measures: 

 
• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver 
is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

 

 
Caution 

Any changes or modifications not expressly approved by the party 

responsible for compliance could void the user’s authority to operate this equipment. 

 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any 

interference received, including interference that may cause undesired operation. 

 
 

For product available in the USA/Canada market, only channel 1~11 can be operated. Selection of 
other channels is not possible. 

This device and it's antennas(s) must not be co-located or operating in conjunction with any other 

antenna or transmitter except in accordance with FCC multi-transmitter product procedures. 
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FCC Radiation Exposure Statement: 
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled 

environment. This equipment should be installed and operated with minimum distance 26 cm 
between the radiator & your body. 

 

IC Statement 

 
This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to 

the following two conditions: (1) this device may not cause interference, and (2) this device must 

accept any interference, including interference that may cause undesired operation of the device. 

 
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio 
exempts de licence. L'exploitation est autorisée aux deux conditions suivantes : (1) l'appareil ne 
doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout brouillage 
radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement. 

 
For product available in the USA/Canada market, only channel 1~11 can be operated. Selection of 
other channels is not possible. 

Pour les produits disponibles aux États-Unis / Canada du marché, seul le canal 1 à 11 peuvent 
être exploités. Sélection d'autres canaux n'est pas possible. 

 
This device and it's antennas(s) must not be co-located or operating in conjunction with any other 
antenna or transmitter except in accordance with IC multi-transmitter product procedures. 

Cet appareil et son antenne (s) ne doit pas être co-localisés ou fonctionnement en association avec 
une autre antenne ou transmetteur. 

 
The device for the band 5150-5250 MHz is only for indoor usage to reduce potential for harmful 
interference to co-channel mobile satellite systems. 

les dispositifs fonctionnant dans la bande 5150-5250 MHz sont réservés uniquement pour une 
utilisation à l’intérieur afin de réduire les risques de brouillage préjudiciable aux systèmes de 
satellites mobiles utilisant les mêmes canaux; 

 

IC Radiation Exposure Statement: 
 

This equipment complies with IC RSS-102 radiation exposure limits set forth for an uncontrolled 

environment. This equipment should be installed and operated with minimum distance 20 cm 

between the radiator & your body. 

Cet équipement est conforme aux limites d'exposition aux rayonnements IC établies pour un 
environnement non contrôlé. Cet équipement doit être installé et utilisé avec un minimum de 20 
cm de distance entre la source de rayonnement et votre corps. 

CE Statement: 
 

This equipment complies with EU radiation exposure limits set forth for an uncontrolled 

environment. This equipment should be installed and operated with minimum distance 20 cm 
between the radiator & your body. 
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Specific expertise and training required for professional installers 

To ensure that the cnPilot Enterprise AP is installed and configured in compliance with the 

requirements of Industry Canada and the FCC, installers must have the radio engineering skills and 

training described in this section. This is particularly important when installing and configuring an 

cnPilot Enterprise AP system for operation in the 5 GHz band (5150 – 5250 MHz – FCC only, 5250 – 

5350 MHz, 5470 – 5725 MHz and 5725 – 5850 MHz). 

Avoidance of weather radars 

The installer must be familiar with the requirements in FCC KDB 443999. Essentially, the installer 

must be able to: 

• Access the FCC database of weather radar location and channel frequencies. 

• Use this information to correctly configure the product (using the GUI) to avoid operation on 

channels that must be avoided according to the guidelines that are contained in the KDB and 

explained in detail in this user guide. 

In ETSI regions, the band 5600 MHz to 5650 MHz is reserved for the use of weather radars. 

External antennas 

When using a connectorized version of the product (as compared to the version with an integrated 

antenna), the conducted transmit power must be reduced to ensure the regulatory limit on 

transmitter EIRP is not exceeded. The installer must have an understanding of how to compute the 

effective antenna gain from the actual antenna gain and the antenna cable losses. 

The product GUI automatically applies the correct conducted power limit to ensure that it is not 

possible for the installation to exceed the EIRP limit, when the appropriate values for antenna gain 

are entered into the GUI. 

Ethernet networking skills 

The installer must have the ability to configure IP addressing on a PC and to set up and control 

products using a web browser interface. 

Lightning protection 

To protect outdoor radio installations from the impact of lightning strikes, the installer must be 

familiar with the normal procedures for site selection, bonding and grounding. 

Training 

The installer needs to have basic competence in radio and IP network installation. The specific 

requirements applicable to the cnPilot Enterprise AP must be gained by reading this user guide 

and by performing sample setups at base workshop before live deployments. 
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About this User Guide 
 

This User Guide describes the features supported by cnPilot Enterprise AP and provides detailed 

instructions for setting up and configuring cnPilot Enterprise AP. 

Intended Audience 
This guide is intended for use by the system designer, system installer and system administrator. 

 

Contacting Cambium Networks 
 

 
Support website: http://www.cambiumnetworks.com/support 

Main website: 

Community: 

http://www.cambiumnetworks.com 

http://community.cambiumnetworks.com 

Sales enquiries: solutions@cambiumnetworks.com 

Support enquiries: support@cambiumnetworks.com 

Telephone number list: http://www.cambiumnetworks.com/support/contact-support/ 

Address: Cambium Networks Limited, 

3800 Golf Road, Suite 360 

Rolling Meadows, IL 60008 

 
 

Purpose 

Cambium Networks cnPilot Enterprise AP documents are intended to instruct and assist personnel 

in the operation, installation and maintenance of the Cambium cnPilot Enterprise AP equipment 

and ancillary devices. It is recommended that all personnel engaged in such activities be properly 

trained. 

Cambium disclaims all liability whatsoever, implied or expressed, for any risk of damage, loss or 

reduction in system performance arising directly or indirectly out of the failure of the customer, or 

anyone acting on the customer's behalf, to abide by the instructions, system parameters, or 

recommendations made in this document. 

 

Cross References 

References to external publications are shown in italics. Other cross references, emphasized in 

green text in electronic versions, are active links to the references. 
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Feedback 

We appreciate feedback from the users of our documents. This includes feedback on the structure, 

content, accuracy, or completeness of our documents. 

For feedback, e-mail to support@cambiumnetworks.com. 
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Problems and Warranty 
 

Reporting Problems 

If any problems are encountered when installing or operating this equipment, follow this 

procedure to investigate and report: 
 

1 Search this document and the software release notes of supported releases. 

2 Visit the support website: 

http://www.cambiumnetworks.com/support 

3 Ask for assistance from the Cambium product supplier. 

4 Gather information from affected units, such as any available diagnostic downloads. 

5 Escalate the problem by emailing or telephoning support: 

http://www.cambiumnetworks.com/support/contact-support 

 
Repair and Service 

If unit failure is suspected, obtain details of the Return Material Authorization (RMA) process from 

the support website. 

 

Warranty 

Cambium’s standard hardware warranty is for one (1) year from date of shipment from Cambium 

or a Cambium distributor. Cambium warrants that hardware will conform to the relevant published 

specifications and will be free from material defects in material and workmanship under normal 

use and service. Cambium shall within this time, at its own option, either repair or replace the 

defective product within thirty (30) days of receipt of the defective product. Repaired or replaced 

product will be subject to the original warranty period but not less than thirty (30) days. 

To register PMP products or activate warranties, visit the support website. 

For warranty assistance, contact the reseller or distributor. 

 

 
Do not open the radio housing for repair or diagnostics; there are no serviceable parts within 

the housing. 

Portions of Cambium equipment may be damaged from exposure to electrostatic discharge. 

Use precautions to prevent damage. 
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Security Advice 
Cambium Networks systems and equipment provide security parameters that can be configured 

by the operator based on their particular operating environment. Cambium recommends setting 

and using these parameters following industry recognized security practices. Security aspects to 

be considered are protecting the confidentiality, integrity, and availability of information and 

assets. Assets include the ability to communicate, information about the nature of the 

communications, and information about the parties involved. 

In certain instances Cambium makes specific recommendations regarding security practices, 

however the implementation of these recommendations and final responsibility for the security of 

the system lies with the operator of the system. 

Cambium Networks cnPilot Enterprise AP equipment is shipped with default web management 

interface login credentials. It is highly recommended that the following default username and 

password should to be modified prior to system deployment. 

Username: admin 

Password: admin 

Warnings, Cautions, and Notes 
The following describes how warnings and cautions are used in this document and in all 

documents of the Cambium Networks document set. 

 

Warning 

Warnings precede instructions that contain potentially hazardous situations. Warnings are used to 

alert the reader to possible hazards that could cause loss of life or physical injury. A warning has 

the following format: 

 
Warning 

Warning text and consequence for not following the instructions in the warning. 

 
Caution 

Cautions precede instructions and are used when there is a possibility of damage to systems, 

software, or individual items of equipment within a system. However, this damage presents no 

danger to personnel. A caution has the following format: 

 

 
Caution 

Caution text and consequence for not following the instructions in the caution. 

 
Note 

A note means that there is a possibility of an undesirable situation or provides additional 

information to help the reader understand a topic or concept. A note has the following format: 
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Note 

Note text. 

 

Caring for the Environment 
The following information describes national or regional requirements for the disposal of 

Cambium Networks supplied equipment and for the approved disposal of surplus packaging. 

 

In EU Countries 

The following information is provided to enable regulatory compliance with the European Union 

(EU) directives identified and any amendments made to these directives when using Cambium 

equipment in EU countries. 

 
Disposal of Cambium Equipment 

European Union (EU) Directive 2002/96/EC Waste Electrical and Electronic Equipment (WEEE) 

Do not dispose of Cambium equipment in landfill sites. For disposal instructions, see 

http://www.cambiumnetworks.com/support 

Disposal of Surplus Packaging 

Do not dispose of surplus packaging in landfill sites. In the EU, it is the individual recipient’s 

responsibility to ensure that packaging materials are collected and recycled according to the 

requirements of EU environmental law. 

 

In non-EU Countries 

In non-EU countries, dispose of Cambium equipment and all surplus packaging in accordance with 

national and regional regulations. 
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Product Description 
 

This chapter provides a high level description of the cnPilot Enterprise AP product. It describes the 

function of the product and the main hardware components. 

The major topics described in this document are: 

• Overview of cnPilot Enterprise AP 

• System configuration 

• Radio configuration 

• WLAN Configuration 

• Network Configuration 

• Guest Access 

• Firewall and ACL 

• Firmware Management 

• Troubleshooting 

 

Overview of cnPilot Enterprise AP 
This section introduces the key features, typical use cases, product variants and components of the 

cnPilot Enterprise AP. 

PURPOSE 

 

cnPilot Enterprise AP is 802.11ac dual band radio Wi-Fi Access point. It is a 2x2:2 (2 spatial 
streams) device and supports over 1Gbps of data rate. It has one Gigabit Ethernet port that also 

provides Power over Ethernet. 

KEY FEATURES 

 

This section describes the key features of cnPilot Enterprise AP: 

 
• Capacity of cnPilot E400/E500: 

o WLANs: 16 
o Clients: 128 for 11ac radio and 256 for 11n radio 

• Capacity of ePMP 1000 Hotspot: 

o WLANs: 8 
o Clients: 128 

• Can be managed via Cambium Networks cnMaestro cloud-based network manager. 

• Supports device configuration by using CLI or UI. 

• Can be monitored via SNMP versions v2 and v3. 

• A Client traffic can be controlled through rate-limiting policies, configured per- 

WLAN or per-client. 

• Supports Captive Portal redirection (Guest Access) with WISPr functionality 

• Supports L3 services such as NAT, port forwarding, DHCP server, and DNS proxy 
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• Access to the network can be controlled based on traffic type and MAC address 
using features such as WLAN and Port Access Control (ACL), DNS based whitelist 

and blacklist, and DoS attack prevention 

• Provides several troubleshooting tools such as Packet Capture, WiFi Analyzer, and 
Connectivity Tests. 

• Supports single hop mesh. 

• Supports roaming protocols such as 802.11r (cnPilot E400/E500 only), OKC and Pre- 
auth 

• Supports Protected Management Frame for cnPilot E400/E500 only (802.11w). 

• Support Band Steering feature which enables improvement in capacity and 

throughput. 

 
DEFAULT SETTINGS 

 

The E400/E500 Access Point is setup to obtain its IP address from a DHCP server. A default IP 
address of 192.168.0.1 will be used if an IP address is not obtained from DHCP. The default 

username and password for CLI as well as GUI (http/https) access are admin / admin. 

 
 

Note 

The default IP address for ePMP 1000 Hotspot is 192.168.0.2. 

LED STATUS 

 
The E400/E500 Access Point has two dual color LEDs. The power LED will glow Orange as the AP 

boots up, and turn Green once it has booted up successfully. The network/status LED will glow 

Orange if the connection to cnMaestro controller/manager is down, and Green once the AP is 

connected successfully to cnMaestro. 

 
Table 1: ePMP 1000 Hotspot LED Status 

 

LED Color Description 

Power Green Powered up 

Eth1 Green Link up 

Blinking Link Activity 

Eth2 Green Link up 

 
Blinking Link Activity 
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Table 1: E400/E500 LED Status 
 

LED Icon Color Description 

System 

 

 

Orange System is starting up. 

Green Started up successfully and operational. 

Network 
 

 

Orange Not connected to cnMaestro. 

Green Connected and Managed by cnMaestro. 
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cnWest-5ghz(config)# 

cnWest-5ghz(config)# wireless wlan 1 

cnWest-5ghz(config-wlan-1)# 

• 

• 

• 

cnWest-5ghz(config-wlan-1)# exit 

cnWest-5ghz(config)# 

• 

• 

 

Command Line Interface (CLI) 

Overview 
The cnPilot Enterprise AP supports a powerful and structured Command Line Interface (CLI) that 

can be used for managing the device over SSH or Telnet. 

The CLI can be used to configure any system parameter, to view the system status and statistics, 
and for actions such as reloading the device, or importing and exporting configuration from it. 

Several troubleshooting tools such as packet-capture and ping are also supported in the CLI. 

 
The CLI is hierarchical, in addition to a global mode for system-wide commands, there are 

separate modes for Wireless LAN, Radio, Etherent, VLAN, and DHCP server configuration. These 

specific modes are entered by specifying the instance of the mode. 

 
Use the following CLI to configure wireless LAN 1 parameters: 

 

 

Use the following CLI to exit from a mode back to the global context type exit command: 
 

 

The default login and password for the CLI are admin. The password can be changed using the 
management user admin password command. 

 
• Entering ? displays the command menu and any context specific help. 

• Pressing <TAB> completes a partially typed CLI command wherever possible. 

• Commands to view system status and statistics begin with show. 

• Commands to default or negate a configuration begin with no. 

 

Example 

Some of the commonly used CLI commands are: 
 

Show config — Displays system configuration 
Save — Used to apply and save any configuration changes 
Show version — Displays the basic device information and firmware version 
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System Configuration 
 

This section describes the System, Management, Time Settings, and Event Logging functionalities 

of cnPilot Enterprise AP. 

System 
The following table lists the fields that are displayed in the Configuration > System page: 

Table 1: Configuration: System parameters 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
1. Navigate to the Configuration > System tab. The following fields are displayed in System: 

a. Enter the hostname of the device in the Name text box. 

b. Enter the location where this device is placed in the Location text box. 

c. Enter the contact details of the device is placed in the Contact text box. 

d. Select the appropriate country code for the regulatory configuration from the Country-Code text 

box. 

Parameter Description Default Value 

Name Hostname of the device. The maximum length of name is 

64 characters. 

─ 

Location The location where the device is placed. The maximum 

length of location is 64 characters. 

─ 

Contact Contact information for the device. ─ 

Country-Code To be set by the administrator to the country-of-operation 

of the device. The allowed operating channels and the 

transmit power levels on those channels depends on the 

country of operation. Radios remain disabled unless this is 

set. The list of countries supported depends on the SKU of 

the device (FCC, ROW etc). 

─ 

PoE Output 

(Only for ePMP 

1000 Hotspot) 

Enable to make the AP provide power an auxiliary device 

connected to its ETH2 interface. Note that the Eth2 

interface provides Cambium PoE (not standard 802.3af) and 

only supported Cambium devices should be plugged into 

that port, when POE-Out is enabled (devices such as other 

ePMPs, PMP450-SM). 

─ 

LED Select the LED checkbox for the device LEDs to be ON 

during operation. 
─ 
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e. Select the LED checkbox for the device LEDs to be ON during operation. 

2. Click Save. 

 

Figure 1: Configuration: System page 
 

 
In the CLI 

 

To change the hostname: 

(cnPilot Enterprise AP) (configure)# hostname <name> 

To change the location: 

(cnPilot Enterprise AP) (configure)# location 

To change the country-code: 

(cnPilot Enterprise AP) (configure)# country-code 

To view the list of all country-codes: 

(cnPilot Enterprise AP) # show country-code 

 

Management 
The following table lists the fields that are displayed in the Configuration > System > Management 
page: 

 
Table 2: Configuration: System > Management parameters 

 

Parameter Description Default Value 

Admin Password Password for authentication of UI and CLI sessions. admin 

Telnet Enable Telnet access to the device CLI. Disabled 

SSH Enable SSH access to the device CLI. Enabled 

HTTP Enable HTTP access to the device UI. Enabled 

HTTPS Enable HTTPS access to the device UI. Enabled 

Cambium 

Remote Mgmt 

Enable support for Cambium Remote Management of this 

device. 

Disabled 
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Cambium ID Cambium-ID used for provisioning cnMaestro (Cambium 

Remote Management) of this device. 

─ 

Cambium 

Password 

Password used for onboarding the device to cnMaestro. ─ 

SNMP 
  

V2 RO 

Community 

SNMP v2c read-only community string ─ 

V2 RW 

Community 

SNMP v2c read-write community string ─ 

V3 Username SNMP v3 username ─ 

V3 Password SNMP v3 password ─ 

Auth Choose MD5 or sha MD5 

Access Choose RO or RW RO 

Encryption Choose ON or OFF ON 

 

You can configure the above parameters through the UI or CLI. 
 

In the UI 

 
1. Navigate to the Configuration > System tab. The following fields are displayed in 

Management: 

a. Enter the admin password of the device in the Admin Password text box. 

b. Enable the Telnet checkbox to enable telnet access to the device CLI. 

c. Enable the SSH checkbox to enable ssh access to the device CLI. 

d. Enable the HTTP checkbox to enable HTTP access to the device UI. 

e. Enable the HTTPS checkbox to enable HTTPS access to the device UI. 

f. Under cnMaestro, enable Remote Management to support for Cambium Remote 

Management of this device. 

g. Enter the URL for cnMaestro in the cnMaestro URL text box. 

h. Enter the Cambium ID of the user in the Cambium ID text box. 

i. Enter the Onboarding Key in the Onboarding Key text box. 

j. Enter the SNMP v2c read-only community string in the V2 RO community text box. 

k. Enter the SNMP v2c read-write community string in the V2 RW community text box. 

l. Enter the SNMP V3 username in the V3 Username text box. 

m. Enter the SNMP V3 password in the V3 Password text box. 

n. Choose MD5 or SHA from the Auth drop-down list. 

o. Choose RO or RW from the Access drop-down list. 

p. Choose ON or OFF from the Encryption drop-down list. 

2. Click Save. 
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Figure 2: Configuration: Management page 

 
In the CLI 

 

To configure management: 

(cnPilot Enterprise AP) (configure)# management {telnet, ssh, http. https} 

To configure Cambium-ID: 

(cnPilot Enterprise AP) (configure)# cambium-id CAMBIUM-ID PASSWORD 

 

Time Settings 

 
The user can configure upto 2 NTP servers. These are used by the AP to set its internal clock to 
UTC/GMT time. Note that the AP does not have a battery backup, and on power-cycle its clock will 

reset to default and needs to sync time again. The servers can be specified as IP addresses or as 
hostname (Eg: pool.ntp.org). 

 
The following table lists the fields that are displayed in the Configuration > System > Time Settings 

page: 

 
Table 3: Configuration: System > Time Settings parameters 

 

Parameter Description Default Value 

NTP Server 1 Name or IP address of a Network Time Protocol server 
1. 

─ 

NTP Server 2 Name or IP address of a Network Time Protocol server 

2. 

─ 
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Timezone Timezone can be set according to the location where the 

AP is installed. By selecting the appropriate timezone 

from the drop-down list, ensures that the device clock is 

synced with the wall clock time. 

Note: Accurate time on the AP is critical for features such 

as WLAN Scheduled Access, Syslogs etc 

─ 

 

You can configure the above parameters through the UI or CLI. 
 

In the UI 

 
1. Navigate to the Configuration > System tab. The following fields are displayed in Time 

Settings: 

a. Enter the name or IP address of the NTP server 1 in the NTP Server 1 text box. 

b. Enter the name or IP address of the NTP server 2 in the NTP Server 2 text box. 

c. Select the time zone settings for the AP from the Timezone drop-down list. 

2. Click Save. 

 

Figure 3: Configuration: Time settings page 
 

 

 
In the CLI 

 

To configure NTP server: 

(cnPilot Enterprise AP) (configure)# ntp <server> 

To configure Timezone: 

(cnPilot Enterprise APv) (configure)# timezone 

To view the current system time: 

(cnPilot Enterprise AP) # show clock 

 

Event Logging 
 

The user can configure upto 2 Syslog servers on the device. All important events regarding device 

operation will be logged into these servers as standard RFC5424 complaint syslog messages. 
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Each message has a mnemonic indicating the type of message, a severity from 0-7 (see the syslog 
wikipedia page for details of this. 0-emergency, 7-debugging etc), as well as a text indicating 

details of the event. 

 
Table 4: Configuration: System > Event logging parameters 

 

Parameter Description Default Value 

Syslog Server 1 IP address of syslog server 1. ─ 

Syslog Server 2 IP address of syslog server 2. ─ 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
1. Navigate to the Configuration > System tab. The following fields are displayed in Event 

Logging: 

a. Enter the IP address of the syslog server 1 in the Syslog Server 1 text box. 

b. Enter the IP address of the NTP server 2 in the Syslog Server 2 text box. 

2. Click Save. 

 

Figure 4: Configuration: Event logging page 
 

 
 

In the CLI 

To configure Event Logging: 

(cnPilot Enterprise AP) (configure)# logging host <ipaddr> 

To delete a previous entry of the event logging: 

(cnPilot Enterprise AP) (configure)# no logging host <ipaddr> 

To view a previous entry of the event logging: 

(cnPilot Enterprise AP) # show logging 
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Onboarding to cnMaestro 

Overview 
cnMaestro is Cambium's next generation network management platform based on Cloud 

technologies. It will eventually replace the entire lineup of Network Management Tools. The initial 
release will include support for ePMP and cnPilot family of devices. Subsequent releases will add 

the remaining devices in the Cambium portfolio. The legacy and 3rd party devices will be 

supported by a proxy application. 

In addition to the Cloud deployment, the solution will also be able to be deployed as a standalone, 

redundant server solution for deployments where access to the Internet is restricted or forbidden. 
 

Onboarding Steps 
You can onboard cnPilot Enterprise AP to cnMaestro using the following steps: 

 
1. To enable Cambium Remote Management: 

 
(cnPIlot Enterprise AP) # management cambium-remote 

 
2. If the device does not have a unique Serial Number (MSN), then set the cambium- 

id/password obtained from Cambium Support: 

 
3. If the device is claimed and is able to reach the cnMaestro, it will get on-boarded. The 

cnMaestro connection status can be seen under “Cambium Remote Management Status”. 

 
To view the connection status: 

 
(cnPIlot Enterprise AP) # cambium-id <cambium-id> <password> 

(cnPIlot Enterprise AP # management cambium-remote 

url https://cloud.cambiumnetworks.com 
 

(cnPIlot Enterprise AP) # apply 

(cnPIlot Enterprise AP) # save 

(cnPIlot Enterprise AP) # show management 

Remote Management 

 
Config : Enabled 

URL : https://cloud.cambiumnetworks.com 
Status: Not Connected 
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Wireless Configuration 
 
 

The wireless settings are divided into the following: 

• Radio configuration 

• WLAN configuration 

 

Radio Configuration 

cnPilot Enterprise AP is a dual band radio solution which operates on 5GHz and 2.4GHz bands 

concurrently. The dashboard menu in the UI displays the channel and band from the CLI, show 
wireless radios displays the details of the radio. 

 
The following table lists the fields that are displayed in the Configure > Radio page and select 
Radio 1(2.4GHz) or Radio 2(5GHz) from the drop-down list. 

 
Table 5: Configure: Radio parameters 

 

 

Parameter Description Default Value 

Enable Enables operation of this radio. ─ 

Channel Primary operating channel. Auto 

Channel Width Operating width of the channel. 20MHz for 2.4GHz and 
80MHz for 5GHz 

Transmit Power Radio transmit power in dBm (1 to 30) ─( * ) 

Beacon interval Beacon interval in ms (100 to 3400) 100 

Multicast Data 

Rate 

Multicast in highest-basic, lowest-basic and highest- 
supported. 

Highest Basic for 
2.4GHz and Lowest 
Basic for 5GHz 

 

  
 

Note: 
Due to FCC restrictions on the maximum EIRP for elevation angles greater than 30deg above the horizon the 
professional installer must manually set the maximum power. 
IT IS THE RESPONSIBILITY OF THE INSTALLER TO ENSURE THAT THE FCC REQUIREMENTS DESCRIBED ABOVE ARE MET 

     Application: Outdoor operation in the 5150-5250MHz band. 
Country code: United States of America 
The EIRP for all outdoor antennas used in the 5.15 - 5.25 GHz band should Not exceed a maximum 125 mW ERIP 
(21dBm) at any elevation angle above 30 degrees (21dBm). 
( * )E.g 

E502s antenna gain: 17 dBi 

The frequency band 5150 – 5250 MHz when antenna above 30 degrees from the horizon power must be reduced. 

Transmit power can only choose 1 in UI. 

 
 

The default channel configuration is set to auto, with this the AP sets the radio to best available 
channel based on the interference and Noise Floor. 
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The country-code set in System page effects channel selection. Only the channels that are allowed 

in the country code should be selected. 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
1. Navigate to the Configure > Radio tab and select Radio 1(2.4GHz) or Radio 2(5GHz) from the 

drop-down list. The following fields are displayed in Radio: 

a. Select the Enable checkbox to enable the operations of this radio. 

b. Select the primary operating channel from the Channel drop-down list. 



2

7 

cnPilot Enterprise AP User Guide CAMBIUM NETWORKS 
 

 

 
c. Select the operating width (20 MHz, 40 MHz, or 80 MHz) of the channel from the Channel 

Width drop-down list for 5 GHz only. We do not support 40 MHz and 80 MHz in 2.4 GHz. 

d. Enter the radio transmit power in the Transmit Power text box. 

e. Enter the antenna gain of connected antenna in the Antenna Gain text box. 

2. Enter the beacon interval in the Beacon Interval text box. 

3. Select Highest Basic or Lowest Basic or Highest Supported from the Multicast data rate 

drop-down list. 

4. Click Save. 

 

Figure 5: Configure: Radio page 

You can configure the radio parameters through the UI or CLI. 

 

In the CLI 

 
To configure radio: 

(cnPilot Enterprise AP) (configure)# wireless radio 1 

 

Advanced Radio Settings 

You can configure the following advanced radio settings on cnPilot Enterprise AP: 

 
• Scheduled ACS (Auto Channel Select) - When Scheduled ACS is configured, the radio 

scans all the channels available in the frequency band and selects the best available 

channel. Scheduled ACS can be configured to scan on-startup or periodic. (Run channel 

selection on specified days at specified time). 
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Table 6: Configure: Radio > Auto Channel Select parameters 
 

Parameter Description Default Value 

Candidate 

Channels 

Select available channel. ─ 

Periodic Run channel selection on specified days at 

specified time. 

─ 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
1. Navigate to the Configure > Radio tab. The following fields are displayed: 

a. Select the Channel as Auto. 

b. Select No Clients radio button if clients are not connected. 

2. Click Save. 

 

Figure 6: Configure: Auto Channel Select page 
 
 

 
In the CLI 

 
To configure Auto Channel Select: 

(cnPilot Enterprise AP) (configure)# wireless radio 1 

(cnPilot Enterprise AP) (config-radio-1)# channel-list 

(cnPilot Enterprise AP) (config-radio-1)# auto-channel-select 

• Enhanced Roaming - When enhanced roaming is enabled, the clients are forced to roam 

when the SNR is below the configured value. This is useful when clients are connected to 

the AP that is far away and stick to that AP. With enhanced roaming, the AP disconnects 

the client is the SNR is less than the configured which makes client to find the better AP 

and roam to it. This is useful in a dense environment and multi-AP setup. It is disabled by 

default and user should understand his deployment topology and then only enable this, 
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user should enable only if he is sure what they want and the threshold should to be set 

accordingly. 

 
The following table lists the fields that are displayed in the Configure > Radio > Enhanced Roaming 
page: 

 
Table 7: Configure: Radio > Enhanced Roaming parameters 

 

Parameter Description Default Value 

Enable Enable active disconnection of clients with 
weak signal. 

Disabled 

Roam SNR 

Threshold 

SNR below which clients will be forced to 

roam (1-100 dB). 

─ 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
1. Navigate to the Configure > Enhanced Roaming tab. The following fields are displayed: 

a. Select the Enable checkbox to enable active disconnection of clients with weak signal. 

b. Enter Roam SNR Threshold value between 1-100. 

2. Click Save. 

Figure 7: Configure: Radio > Enhanced Roaming tab 
 
 

In the CLI 

 
To configure Enhanced Roaming: 

(cnPilot Enterprise AP) (configure)# wireless  radio 1 

(cnPilot Enterprise AP) (config-radio-1)# enhanced-roaming 

(cnPilot Enterprise AP) (config-radio-1)# enhanced-roaming threshold 

 

WLAN Configuration 
This section provides details on configuring WLAN Configuration parameters. 

The following table lists the fields that are displayed in the Configure > WLAN page: 
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Table 8: Configure: WLAN Configuration parameters 
 

Parameter Description Default Value 

Enable To enable a particular WLAN. Disabled 

SSID The SSID of this WLAN (Upto 32 characters). ─ 

VLAN Default VLAN assigned to clients on this 

WLAN. (1-4094). 

─ 

Security Displays the security type 

• Open 

• WPA2 Pre-shared Keys 

• WPA2 Enterprise 

─ 

Passphrase WPA2 Pre-shared Security passphrase or 

key. 

─ 

Radios Defines radio types (2.4GHz, 5GHz) on 

which this WLAN should be supported. 

─ 

Max Clients Max Client assigned to this WLAN. (0-255) 127 

Client Isolation Prevents wireless clients from 

communicating with each other. The client 

devices does not connect with each other. 

─ 

Hide SSID Prevents broadcasting SSID in beacons. Disabled 

Proxy ARP Responds to ARP requests automatically on 

behalf of clients 

─ 

UAPSD To enable or disable U-APSD Disable 

QBSS To enable or disable QBSS Disable 

DTIM interval Configure DTIM interval 1 

Band Steering Steer dual band capable clients towards 

5GHz radio. 

─ 

Fast-Roaming 

Protocol 

One of the important aspect to support 
voice applications on Wi-Fi network (apart 

from QoS) is how quickly a client can 

move its connection from one access 
point to another. This should be less than 

150 msec to avoid any call drop. This is 

easily achievable when  WPA2-PSK 

security mechanism is in use. However, in 
enterprise environments there is a need 

for more robust security (the one provided 

by WPA2-Enterprise). With WPA2- 
Enterprise, the client exchanges multiple 

frames with AAA server and hence 

─ 
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 depending on the location of AAA server 

the roaming-time will be above 700 msec. 

Select any one of the following: 

• Pre-authentication: This roaming 

method was proposed in 802.11i 

standard. Access points 

supporting this method indicates 

their capability using pre- 

authentication flag in RSN 

capabilities element of the RSN-IE 

• OKC: This roaming method is a 

proprietary solution to bring 

scalability to the roaming 

problem. This method avoids the 

need to authenticate with AAA 

server every time a client moves 

to new access point. 

• 802.11r: This is the IEEE standard 

for fast roaming, introduces a new 

concept of roaming where the 

initial handshake with the new AP 

is done even before the client 

roams to the target AP, which is 

called Fast Transition (FT). 

 

802.11 w State 802.11 w, also termed as Protected 

Management Frames (PMF) Service, 

defines encryption for management 

frames. Unencrypted management frames 

makes wireless connection vulnerable to 

DoS Attacks as well as they cannot protect 

important information exchanged using 

management frames from eavesdroppers. 

Select any one of the following: 

• Disable 

• Optional 

• Mandatory 

─ 

 

You can configure the above parameters through the UI or CLI. 
 

In the UI 

 
1. Navigate to the Configure > WLAN tab. The following fields are displayed: 

a. Select the Enable checkbox to enable a particular WLAN. 
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b. Enter the SSID name for this WLAN in the SSID textbox. 

c. Enter the default VLAN assigned to the clients on this WLAN in the VLAN 

textbox. 

d. Select the security type as Open, WPA2 Pre-shared Keys, or WPA2 Enterprise from the Security 
drop-down list. 

e. Select the Client Isolation checkbox to prevent wireless clients from connecting to each 
other. 

f. Select the Hide SSID checkbox for not broadcast SSID in beacons. 

g. Select Proxy ARP checkbox for responding to ARP requests automatically on behalf of clients. 

h. Select the UAPSD checkbox to enable UAPSD. 

i. Select the QBSS checkbox to enable QBSS. 

j. Enter the value in the DTIM interval text box to configure DTIM interval. 

k. To enable band steering feature, select Band Steering checkbox. 

l. Select the type of Fast-Roaming Protocol as Pre-authentication, OKC, or 

802.11r. 

m. Select 802.11w State as Disable, Optional, or Mandatory. 

2. Click Save. 

Figure 8: Configure: WLAN Configuration page 

 

 

 
In the CLI 

 
To configure wlan: 

(cnPilot Enterprise AP) (configure)# wireless wlan 1 
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To configure SSID: 

(cnPilot Enterprise AP) (config-wlan-1)# ssid<name> 

To configure security: 

(cnPilot Enterprise AP) (config-wlan-1)# security wpa2-psk 

(cnPilot Enterprise AP) (config-wlan-1)# passphrase <string> 

To view the client status: 

(cnPilot Enterprise AP) (config)#show wireless clients 

To view the client statistics 

(cnPilot Enterprise AP) (config)#show wireless clients statistics 

To configure 802.11w: 

 
 

(cnPilot Enterprise AP) (config)# protected-mgmt-frames  sa-query-retry-time  msecs 

(cnPilot Enterprise AP) (config)# protected-mgmt-frames association-comeback  secs 

(cnPilot Enterprise AP) (config)# [no] protected-mgmt-frames state optional | mandatory 

To configure Fast Roaming Protocol: 

(cnPilot Enterprise AP) (config)# fast-roaming pre-authentication 

(cnPilot Enterprise AP) (config)# fast-roaming okc 

(cnPilot Enterprise AP) (config)# fast-roaming 802.11r 

(cnPilot Enterprise AP) (config)# fast-roaming 802.11r over-the-ds 

(cnPilot Enterprise AP) (config)# fast-roaming 802.11r reassociation-timeout x #Reassociation time out 

in secs 

 

Configuring RADIUS Servers 
RADIUS accounting allows user activity and statistics to be reported from the device to RADIUS 

servers. 

This section provides details on configuring parameters for RADIUS Servers. 

The following table lists the fields that are displayed in the Configure > WLAN > RADIUS Servers 
page: 

 
Table 9: Configure: RADIUS Servers parameters 

 

Parameter Description Default Value 

Authentication 

Server 

IP address of the host for the authentication server. ─ 

Timeout Timeout in seconds of each request attempt. ─ 

Attempts Number of attempts before a request is given up. ─ 

Accounting 

Server 

IP address of the host for the accounting server. ─ 

Timeout Timeout in seconds of each request attempt. ─ 
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Attempts Number of attempts before a request is given up. ─ 

Accounting Mode start-stop: 

Start-interim-stop: 

None: 

 

Server Pool Mode Load Balance: Load balance requests equally among 

configured servers. 

Failover: Move down server list when earlier servers 

are unreachable. 

─ 

NAS Identifier NAS-Identifier attribute to use in request packets. 

Defaults to system name. 

─ 

Interim Update 

Interval 

Interval for accounting interim stats update (60-65535). 120 

 

You can configure the above parameters through the UI or CLI. 
 

In the UI 

 
1. Navigate to the Configure > WLAN > RADIUS Servers tab. The following fields are displayed: 

a. Enter the IP address of the host for the authentication server in the host textbox. 

b. Enter the shared key for this host in the Shared textbox. 

c. Enter the Port in the Port textbox. 

d. Enter the time in seconds of each request attempt in Timeout textbox. 

e. Enter the number of attempts before a request is given up in the Attempts textbox. 

f. Enter the IP address of the host for the accounting server in the host textbox. 

g. Enter the shared key for this host in the Shared textbox. 

h. Enter the Port in the Port textbox. 

i. Enter the time in seconds of each request attempt in Timeout textbox. 

j. Enter the number of attempts before a request is given up in the Attempts textbox. 

k. Select any one of the Server Pool Mode: 

• Load Balance 

• Failover 

l. Enter the interval for accounting interim stats update (60-65535) in the Interim Update Interval 

textbox. 

m. Enter the NAS identifier in the NAS Identifier textbox. 

n. Select the Dynamic Auth checkbox to configure dynamic authorization for wireless clients. 

2. Click Save. 
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Figure 9: Configure: RADIUS Servers page 

 
 
 
 

In the CLI 

 
To configure RADIUS server: 

(cnPilot Enterprise AP) (configure)# wireless wlan 1 

(cnPilot Enterprise AP) (config)#wireless wlan <WLAN_IDX> 

(cnPilot Enterprise AP) (config-wlan)#radius-server authentication host <1-3> <HOSTIP> 

(cnPilot Enterprise AP) (config-wlan)#radius-server authentication port <1-3> 
<1-65535> 

(cnPilot Enterprise AP) (config-wlan)#radius-server authentication secret <1-3> <WORD> 

(cnPilot Enterprise AP) (config-wlan)#radius-server authentication realm <1-3> <WORD> 

(cnPilot Enterprise AP) (config-wlan)#radius-server authentication  timeout  <1-30> 

(cnPilot Enterprise AP) (config-wlan)#radius-server authentication  attempts  <1-3> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting host <1-3> <HOST-IP> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting port <1-3> <1-65535> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting secret <1-3> <WORD> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting realm <1-3> <WORD> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting timeout <1-30> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting attempts <1-3>  

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting interim-update-interval 
<60-65535> 

(cnPilot Enterprise AP) (config-wlan)#radius-server accounting mode <start-stop|startinterim- 
stop|none> 
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Wireless Mesh 

Overview 

With System release 2.0, cnPilot access points as well as the ePMP1000 Hotpot support mesh 

connections between radios. A single mesh hop is supported in release 2.0 with experimental support 
for multiple mesh hops. Mesh links can form between radios of the same band of operation (2.4GHz or 

5GHz), but the two peers of the mesh link don’t have to be of the same AP-type: a link between an 

ePMP1000 Hotspot and cnPilot E400/E500 is supported. Given the larger set of available channels and 

typically cleaner RF environment we recommend using the 5GHz radio for mesh backhaul if the AP is 

5GHz-capable, such as the E400/E500. 
 

A mesh link can be created between two radios by configuring one of them as a BASE and the other as 
a CLIENT on the first WLAN of the AP. Typically the access point which has wired connectivity would 

be configured as a mesh base. The radio setup for mesh base will select a channel and start 

transmitting beacons as soon as the AP comes up. The radio setup for mesh client will scan all 

available channels, looking for a mesh base radio to connect with. The SSID in the mesh WLAN is how 

the client and base radios of a mesh link identify each other, the same SSID should be configured on 
the mesh BASE WLAN as well as the mesh CLIENT WLAN. 

 
In addition to a simple topology between a base and a client, a “star” or “hub-and-spoke” mesh 

topology is also supported: a mesh radio can service upto 5 mesh clients connected to it. When a 

radio is configured with a mesh WLAN, on that WLAN other clients are not allowed to connect, 

however the radio can service clients on other WLANs mapped to it. Note that a client radio will start 

rescanning all available channels as soon as it loses connectivity to the base. During this scan period 
other WLANs mapped to it will not be operational. 

 
The mesh link can be also be secured with WPA2-Preshared-Keys. The same passphrase should be 

configured on both the mesh BASE as well as the mesh CLIENT. Standard 802.11 security handshakes 

and AES-CCM encryption are then used on the mesh link.” 

 

Deployment 

The following diagram illustrates the working scenario of wireless mesh network: 
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The following diagram shows the list of connected mesh peers in the dashboard: 

 

Figure 10: Mesh Peers 
 

 

Typical Use-Cases 
• WiFi access in areas with no cable run 

• Small retail location with one AP near an Ethernet outlet, another in the middle of 

lobby that has no easy cable run. 
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• Extend range outdoors 
• An ePMP1000 Hotspot in a parking lot outside a building, with E400/E500 providing 

WiFi within the building 

• Plug coverage holes 

• Add an AP indoor/outdoor for the areas that are difficult to reach 

Configuring Wireless Mesh 
The following table lists the fields that are displayed in the Configure > WLAN > Basic page: 

Table 10: Configure: WLAN > Basic parameters 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The wireless Mesh can be configured by using the UI or the CLI. 

To configure the Mesh Client or Mesh Base: 

In the UI 

1. Navigate to the Configure > WLAN > Basics tab. The following fields are displayed: 

a. Select Enable checkbox. 

b. Choose Base, Client or Off from the Mesh drop-down list. 

c. Enter the name of the WLAN in the SSID textbox. 

d. Select the security type for this client as open or WPA2 Pre-Shared Keys from the Security 

drop-down list. 

e. Enter the WPA2 pre-shared passphrase or key in the Passphrase textbox. 

f. Choose the RADIO type (5GHz or 2.4GHz) on which the WLAN should be supported from 

the Radios drop-down list. 

g. Select the Hide SSID checkbox for not broadcasting the SSID. 

2. Click Save. 

Parameter Description Default Value 

Mesh Configures the Mesh feature. Select Base, Client or 
Off from the Mesh list. 

─ 

SSID The WLAN name that is seen by the wireless 
clients. 

─ 

VLAN The VLAN ID to be used for this WLAN. 1 

Security Select the security type for this client. ─ 

Passphrase The WPA2 pre-shared security passphrase or key. ─ 

Radios The RADIO type on which this WLAN should be 

supported. 

─ 

Hide SSID Select this option for not broadcasting the SSID in 

beacons. 

─ 
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Figure 11: Configure: WLAN > Basic page 
 
 

In the CLI 

 
To configure Mesh: 

(cnPilot Enterprise AP) (configure)# wireless wlan 1 

(cnPilot Enterprise AP) (config-wlan-1)# {base,client} 

Notes 

1. In SW release 2.0, a single mesh hop is supported, multiple hops can be configured but 

support is experimental. 
2. There is a large throughput drop when using a radio for client access as well as mesh link 

(over 50%) since each packet would traverse the air twice, once from the client to the AP, 
then from the AP to its mesh peer. 

3. Access Points have to be configured independently for mesh, a new AP will not connect out-of- 
the-box with an existing mesh network. Mesh mode (client/base), the SSID and the security 
configuration has to be done from the device GUI or CLI. 

 

Usage Limit 

Usage Limit is a WLAN feature that allows to configure the maximum threshold value of bandwidth 
allowed either per client or per WLAN in both downlink and uplink traffic directions. 
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Guest Access 
 

Guest access feature is used to provide a web-based network access control process where a client 

is redirected to a login page to gain network access. The clients can have a simple click-through 

login process or a RADIUS authentication based access mode. Without a login no network traffic is 

allowed from the client apart from DHCP and DNS packets. Traffic to specific IP addresses can be 

allowed using the whitelist configuration for the un-authenticated clients. 

Configuring Guest Access 
Administrator can configure a set of whitelist IP address which guest access clients can access 

without doing a login. This configuration also becomes handy when an external web portal is 

being used for providing the login/welcome pages. Administrator can give a secured http 

connection for the login where the communication between the access point and the client will be 

secured. Administrator can also configure the page title and welcome message as per his own 

requirements. 

The following table lists the fields that are displayed in the Configure > WLAN > Guest Access 

page: 

 
Table 11: Configure: Guest Access parameters 

 

Parameter Description Default Value 

Enable Enables the Guest Access feature. Disable 

Access Policy There are two types of access types provided for 

the end user, click-through and another being the 

RADIUS authentication mode. The click-through 

can also be combined with additional terms and 

condition content which can tell end users the 

terms of the network usage. 

─ 

Redirect Mode You can use http or https URLs for redirection. ─ 

Splash Page Select On Device or URL radio button. ─ 

Title Title text in splash page. ─ 

Contents Main contents of the splash page. ─ 

Terms The admin can configure his own text for the 

terms and condition in the CLI/UI or he can load 

terms and condition content file from CLI using a 

service command. If a terms and condition content 

file is loaded then it will be common across all 

WLAN configuration if guest access is enabled on 

them. 

─ 

Success Action Select any one of the following: 

• Internal Logout Page 

─ 
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• Redirect User to External URL 

• Redirect user to Original URL 

 

Success 

message 

The message to be displayed in the login page 

after successful authentication. 

─ 

Session 

Timeout 

Administrator can configure a limited session time 

for each session after which a re-login will be 

enforced. 

─ 

Inactivity 

Timeout 

Administrator can also configure an inactivity time 

for deleting those clients which went away without 

doing a proper guest access logout and free up the 

consumed resources by that client. Such a 

configuration is very helpful for public hotspots 

where free network is provided and clients go 

away without doing a logout. 

─ 

 

The RADIUS server configuration is used for RADIUS access type guest access and one can also 

enable RADIUS accounting for the guest access clients. 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
1. Navigate to the Configure > WLAN > Guest Access tab. The following fields are displayed: 

a. Select Enable checkbox to enable guest access feature. 

b. Choose the Access Policy as Click through or Radius. 

c. Choose the Redirect Mode as HTTP or HTTPS. 

d. Choose the login page to be on device login page or an external URL. 

e. Enter the title to appear in the splash page in the Title textbox. 

f. Enter the content to appear in the splash page in the Contents textbox. 

g. Enter the terms and conditions to appear in the splash page in the Terms textbox. 

h. Enter the success message to appear in the Success Message textbox. 

i. Enter the session timeout in seconds in the Session Timeout textbox. 

j. Enter the inactivity timeout in seconds in the Inactivity Timeout textbox. 

2. Click Save. 

To configure the whitelist parameter: 

1. Enter the IP address or the domain name of the permitted domain in the IP Address or 

Domain Name textbox. 

2. Click Save. 
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Figure 12: Configure: Guest Access page 
 

 

 

 
 

In the CLI 

 
To configure Guest Access: 
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(cnPilot Enterprise AP) (configure)# wireless wlan 1 

(cnPilot Enterprise AP) (config)#wireless wlan <WLAN_IDX> 

(cnPilot Enterprise AP) (config-wlan)#guest-access access-type <click-through|radius> 

(cnPilot Enterprise AP) (config-wlan)#guest-access connection-mode  <http|https> 

(cnPilot Enterprise AP) (config-wlan)#guest-access splash-page terms-message <TEXT> 
(cnPilot Enterprise AP) (config-wlan)#guest-access splash-page text <TEXT> 

(cnPilot Enterprise AP) (config-wlan)#guest-access splash-page title <TITLE> 

(cnPilot Enterprise AP) (config-wlan)#guest-access splash-page URL <URL> 

(cnPilot Enterprise AP) (config-wlan)#guest-access success-action <redirect-url| 
logout-page> 

(cnPilot Enterprise AP) (config-wlan)#guest-access success-action logout-page text 
<TEXT> 

(cnPilot Enterprise AP) (config-wlan)#guest-access session-time <60-86400> 

(cnPilot Enterprise AP) (config-wlan)#guest-access inactivity-time <60-28800> 

(cnPilot Enterprise AP) (config-wlan)#guest-access whitelist <IP_ADDRESS> 
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Network Configuration 
 

This section introduces the configuration of various network elements such as Ethernet ports, 

SVIs, DHCP servers, DNS proxy, management VLAN access, NAT, and port forwarding. Depending 
of the use case, the required elements can be configured. 

 

Ethernet Ports 
The following table describes the parameters displayed in the Network Configuration > Ethernet 
Configuration page. 

 
Table 12: Configure: Ethernet Ports parameters 

 

Parameter Description Values 

Mode Configure Ethernet port in either trunk or access mode. 

Trunk Mode: Allows traffic with different user defined 

VLANs (refer allowed VLANs list) to egress & ingress. 

One of these VLANs can be defined as native VLAN. 

Traffic with native VLAN will map to untagged traffic 

based on whether native VLAN is tagged or untagged. 

Access Mode: Allows traffic with specific user defined 

VLAN (called access VLAN) to egress as untagged and 

allowed only untagged traffic to ingress and map to 

access VLAN. 

trunk/access 

Default mode for 

Eth1 and Eth2 is 

access. 

Access 

VLAN* 

Untagged traffic on access port will map to the access 

VLAN inside the device. 
1 - 4094 

Allowed 

VLANs^ 

List of all VLANs which are allowed to ingress and 

egress from the trunk port and are separated by 

commas. 

E.g. 1,14,100,200-567 

VLAN List 

Native 

VLAN^ 

Marks one of the VLANs from allowed VLAN list as 
native VLAN. 

1-4094 

Native 

Tagged^ 

Maps native VLAN traffic of device to untagged traffic 
on Ethernet (when enabled) otherwise keep it tagged on 
Ethernet side. 

Enable/Disable 

*: valid only in access mode 

^: valid only in trunk mode 
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Figure 13: Configure: Network Configuration page 
 

 

 
In the CLI 

 
To switch from configuration context to interface context: 

(cnPilot Enterprise AP) (configure)# interface eth port-num 

To configure port mode (default is trunk mode): 
(cnPilot Enterprise AP) (configure)# switchport mode access/trunk 

To configure default VLAN of access port (default 1): 

(cnPilot Enterprise AP) (configure)# switchport access vlan vlan-id 

To configure allowed VLAN range for trunk port (defaults 1 to 4094): 

(cnPilot Enterprise AP) (configure)# switchport trunk allowed vlan vlan-range 

To specify native VLAN for the trunk port (default 1): 

(cnPilot Enterprise AP) (configure)# switchport trunk native vlan vlan-id 

To enable native VLAN tagging: 

(cnPilot Enterprise AP) (configure)# switchport trunk native tagged 

To disable native VLAN tagging: 
(cnPilot Enterprise AP) (configure)# no switchport trunk native tagged 

To display L2 parameters of the ports: 

(cnPilot Enterprise AP) (configure)# show interface  brief 

 

Switched Virtual Interface (SVI) 

SVI represents virtual interfaces each mapped to a specific VLAN. Each SVI can have static IP or 

assigned from external DHCP server. 

 
Table 13: Configure: SVI parameters 

 

Parameter Description Values 

IP Mode / 

Address 

Configures either IP mode to DHCP or static 

IP to the SVI. 

Note: Each SVI should have IP in unique 

subnet. 

dhcp 

or 

ip-addr/mask 
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zeroconf Creates additional zeroconf IP (169.254.x.y) 

on the interface alias. 

Only valid for SVI with VLAN 1. 

Enable/Disable 

 

You can configure the above parameters through the CLI. 
 

In the CLI 

 

To switch from configuration context to SVI context: 

(cnPilot Enterprise AP) (configure)# interface vlan vlan-id 

To configure IP address mode to DHCP client: 

(cnPilot Enterprise AP) (configure)# ip address  dhcp 

To configures static IP address with a network mask of x bits: 

(cnPilot Enterprise AP) (configure)# ip address a.b.c.d /x 

To configures zeroconf (169.254.x.y) IP on SVI: 

(cnPilot Enterprise AP) (configure)# ip address zeroconf 

To disable zeroconf IP on an interface: 

(cnPilot Enterprise AP) (configure)# no ip address zeroconf 

 
To display all the created SVIs along with their VLAN and IP address information: 
(cnPilot Enterprise AP) (configure)# show ip interface brief 

 
Figure 14: Configure: Network > VLAN page 

 
 

DHCP Server 
Configures on board DHCP server on a particular SVI. User can configure different DHCP servers 

on up to 16 SVIs. Mapping between DHCP server and SVI is done through SVI IP address & 

network parameter of DHCP server configuration. 

 
Table 14: Configure: DHCP Server parameters 

 

Parameter Description Values 

IP Address 

Range 

Specifies the range of IP address to be used for assigning 

to the clients. 

start-ip-address to 

end-ip-address 
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Default 

Router IP 

Specifies IP address of the default gateway to be 

assigned to the clients 

ip-addr 

Primary & 

Secondary 

DNS 

Server IP 

Specifies IP address of the domain name servers. 

Default values: 

8.8.8.8 & 8.8.4.4 (when dns proxy is configured at device) 

SVI IP & none (when dns proxy is not configured on 

device) 

ip-addr1 

ip-addr2 (optional) 

Domain 

Name 

Specifies the domain name to be assigned to clients. string 

Lease 

Time 

Specifies the lease time. days – hours - 

minutes 

network Specifies subnet of SVI to which this DHCP server should 

attach. 

ip-addr/mask 

MAC-IP 

Bindings 

Specifies specific binding between MAC address and IP 

address. 

mac-addr ip-addr 

 

You can configure the above parameters through the CLI. 

 

In the CLI 

 

To switch from configuration context to DHCP pool context: 

(cnPilot Enterprise AP) (configure)# ip dhcp pool pool-num 

 
To configure IP address range to be assigned to the clients: 

(cnPilot Enterprise AP) (configure)# address-range a.b.c.d A.B.C.D 

 
To configure default router IP to be assigned to clients. Default router, if present in address range 

is excluded. 

(cnPilot Enterprise AP) (configure)# default-router a.b.c.d 

To configure primary and secondary DNS server IP to be assigned to clients. Default Value: 8.8.8.8 
for primary & 208.67.222.222 for secondary: 

(cnPilot Enterprise AP) (configure)# dns-server primary-server-ip secondary-server-ip 

 
To configure domain name to be assigned to clients: 
(cnPilot Enterprise AP) (configure)# domain-name 

 
To configure lease time: 

(cnPilot Enterprise AP) (configure)# lease days hrs min 

 
To specify subnet (SVI) to attach with DHCP server: 

(cnPilot Enterprise AP) (configure)# network a.b.c.d /x 

To bind IP address with MAC address. Up to 32 bindings can be specified: 

(cnPilot Enterprise AP) (configure)# bind xx:xx:xx:xx:xx:xx a.b.c.d 
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To destroy the specified DHCP pool: 

(cnPilot Enterprise AP) (configure)# no ip dhcp pool pool-num 

To display the pool status, SVI on which DHCP pool is attached & assigned leases to all client from this pool: 

(cnPilot Enterprise AP) (configure)# show dhcp-pool pool-num 

Figure 15: Configure: Network > DHCP page 
 

 
 
 

DHCP Relay 

DHCP relay allows DHCP server in one subnet to be shared by clients in other subnet by relaying 

DHCP requests. Relay agent configuration is specific to SVI. i.e. any SVI / subnet looking for DHCP 

server in different subnet needs to have relay agent configured for it. 

 
Table 15: Configure: DHCP Relay parameters 

 

Parameter Description Value 

DHCP 

Server IP 

Specifies the IP address of the DHCP server which should 

be used of the given subnet. 

Note: It automatically enables relay w/o any additional 

command. 

ip-address 

 
You can configure the above parameters through the CLI. 

In the CLI 

 
To switch from configuration context to SVI context. 

(cnPilot Enterprise AP) (configure)# interface vlan vlan-id 

To configure DHCP relay for the SVI with a.b.c.d as the DHCP server IP address. 

(cnPilot Enterprise AP) (configure)# ip dhcp relay server a.b.c.d 

To display relay: 

(cnPilot Enterprise AP) (configure)# no ip dhcp relay 

 

DNS Proxy 
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DNS proxy enables local caching of DNS entries from all the interfaces configured on the device. 

For the queries which cannot be answered from the local cache, external servers are referred. 

 

Table 16: Configure: DNS Proxy Parameters 
 

Parameter Description Value 

State Configures the state of DNS proxy on the device. Enable/Disable 

External 

name server 

IP address of external name server to be referred 

by DNS proxy. Up to two name server can be 

defined. Additionally, any name servers passed 

by external DHCP servers will also be used as 

external DHCP server. 

Ip-address 

 
You can configure the above parameters through CLI. 

 

In the CLI 

 
To enable DNS server / proxy: 

(cnPilot Enterprise AP) (configure)# ip dns server 

To disable DNS server / proxy: 
(cnPilot Enterprise AP) (configure)# no ip dns server 

To configure single external name server: 

(cnPilot Enterprise AP) (configure)# ip name-server a.b.c.d 

 
Figure 16: Configure: Network > VLAN page 

 

 

Management VLAN Access 

The management VLAN access allows to restrict device access using a given set (one or more) 

VLANs. Additionally, access using a given VLAN can be allowed only from wired connection. 

 
Table 17: Configure: Management VLAN Access Parameters 

 

Parameter Description Values 

state Management VLAN access is per SVI configuration. Disable / allow- 

from-wired / allow- 
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 Disabled: No access of device using this SVI’s VLAN 

Allow-from-wired: Access of device is allowed from 

wired side using this SVI’s VLAN 

Allow-from-both-wired-wireless: Access of device is 

allowed from both wired & wireless side using this 

SVI’s VLAN 

from-both-wired- 

wireless 

 

You can configure the above parameters through the CLI. 

 

In the CLI 

 
To switch from configuration context to SVI context: 

(cnPilot Enterprise AP) (configure)# interface vlan vlan-id 

To enable management access through given SVI. Access from both wired and wireless is allowed: 

(cnPilot Enterprise AP) (configure)# management-access all 

To enable management access through given SVI. Access from only wired side is permitted: 

(cnPilot Enterprise AP) (configure)# management-access wired 

To disable management access through given SVI: 
(cnPilot Enterprise AP) (configure)# no management-access 

 

NAT and Port Forwarding 
NAT allows to hide IP addresses of a subnet while accessing IP addresses in another subnet. Each 

SVI / Subnet needs to be individually configured for NAT. 

You can configure NAT using the UI and CLI: 

 
In the UI 

 
Figure 17: Configure: NAT 

 

 
In the CLI 

 
To switch from configuration context to SVI context: 
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(cnPilot Enterprise AP) (configure)# interface vlan vlan-id 

To enable NAT for the SVI: 

(cnPilot Enterprise AP) (configure)# ip nat inside 

To disable NAT for the SVI: 

(cnPilot Enterprise AP) (configure)# no ip nat 

 
 

Port Forwarding allows to forward traffic with specific TCP / UDP ports to specific server in NAT 

enabled subnet. As oppose to NAT which is SVI specific, port forwarding is a global configuration. 

You can configure NAT using UI and the CLI: 

 
In the UI 

 
1. Navigate to the Configure > Network > Routes tab. The following fields are displayed: 

 
a. Enter the port number in the Port textbox. 

b. Enter the IP address in the IP Address textbox. 

c. Select the type as TCP or UDP from the Type drop-down list. 

 
2. Click Save. 

 

Figure 18: Configure: Network > Port Forwarding page 
 
 

In the CLI 

 

To forward TCP port-num to a.b.c.d server: 

(cnPilot Enterprise AP) (configure)# ip port-forward tcp port-num a.b.c.d 

To forward UDP port-num to a.b.c.d server: 

(cnPilot Enterprise AP) (configure)# ip port-forward udp port-num a.b.c.d 

To disable forwarding of TCP port-num to a.b.c.d server: 
(cnPilot Enterprise AP) (configure)# no ip port-forward tcp port-num a.b.c.d 
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To disable forwarding of UDP port-num to a.b.c.d server 

(cnPilot Enterprise AP) (configure)# no ip port-forward udp port-num a.b.c.d 
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Firewall 
 

Firewall options are used to configure options to protect form denial of service (DoS) attacks. By 

configuring these options AP prevents attacks on its Ethernet and wireless interface so that it does 
not enter in DoS state for its wireless clients. 

 

Configuring Firewall 
You can configure Firewall using the UI or CLI: 

 
In the UI 

 
1. Navigate to the Configure > Network tab. The following fields are displayed: 

a. To enable IP spoof, select IP Spoof checkbox. 
b. To enable smurf attack protection, select Smurf Attack checkbox. 

c. To enable IP spoof log, select IP Spoof Log checkbox. 
d. To enable fragmented ping attack protection, select ICMP Fragment checkbox. 

 
2. Click Save. 

Figure 19: Configure: Network > Firewall page 
 
 

 

In the CLI 

 
(cnPilot Enterprise AP) (configure)# firewall dos-protection {icmp-frag, ip-spoof, ip-spoof-log, smurf-atttack} 

 

ACL 

ACL provides basic traffic filtering capabilities based on selected type of ACL, for example if user 

configures an IP ACL then from A.B.C.D. IP address to M.N.O.P IP address traffic will be dropped. 

The AP examines each packet to determine whether to forward or drop the packet, on the basis of 

the criteria such as: 

• Allow or Deny criterion 

• Source or Destination IP address of the traffic 

• Source or Destination MAC address of the traffic 

• Upper-layer protocol types 
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• Source or destination port information. 

A maximum of 256 rules per network interface and rules are processed in the order of precedence 

(1=high; 256=low). 

Configuring ACL 

You can configure ACL using the UI and the CLI. 

 

In the UI 

 
1. Navigate to the Configure > WLAN > Access tab. The following fields are displayed: 

a. Select preference from the Preference drop-down list. 

b. Select type of policy from Policy drop-down list. 

c. Select direction from the Direction drop-down list. 

d. Select type from the Type drop-down list. 

e. Enter IP address of source in the Source IP text box. 

f. Enter IP address of destination in the Destination IP text box. 

2. Click Save. 

 

Figure 20: Configure: Network > ACL page 
 
 

 

In the CLI 

 
(cnPilot Enterprise AP) (config-wlan-1# acl {deny, permit} 

(cnPilot Enterprise AP) (config-wlan-1# acl deny {ip, mac, proto} 

(cnPilot Enterprise AP) (config-wlan-1)# acl permit ip 

acl permit ip PRECEDENCE (SOURCE-IP{/{mask|prefix-length}}|any) (DESTINATION-IP{/{mask|/prefix- 
length}}|any) (in|out|any) 

 
Example: acl permit ip 255 any any any 

 
(cnPilot Enterprise AP) (config-wlan-1)# acl permit proto 
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acl permit proto PRECEDENCE (tcp|udp|icmp|any) (SOURCE-IP{/{mask|prefix-length}}|any) (SOURCE-PORT|any) 

(DESTINATION-IP{/{mask|prefix-length}}|any) (DESTINATION-PORT|any) (in|out|any) #Please ignore port for ie 

Example: acl permit proto 30 tcp any any any 10000 out 

 
 

Note 
If ACL rules are configured and there is no matching rule exist then by default packets will be 

dropped. So it is advised to add default rule with lower priority to allow or deny un-matched 

traffic. 

 

DNS ACL 

DNS ACL gives URL filtering based on the domain name in DNS Requests. User can configure 

allow or deny list based on the requirements. If a domain has been configured as allow then the 

wireless clients can load that URL. If a domain has been kept as deny then those URLs will be 

blocked by AP Wildcards as domain names are supported (Eg: *.google.com). You can configure 

upto 256 entries per WLAN. 

Configuring DNS ACL 

You can configure DNS ACL using the UI or CLI: 
 

In the UI 

 
3. Navigate to the Configure > WLAN > Access tab. The following fields are displayed: 

 
a. Select preference from the Preference drop-down list. 

b. Select type of action from Action drop-down list. 

c. Enter domain name in the Domain text box. 

 
4. Click Save. 



5

7 

cnPilot Enterprise AP User Guide CAMBIUM NETWORKS 
 

 

 

Figure 21: Configure: Network > DNS-ACL page 
 
 

 

 
In the CLI 

 
(cnPilot Enterprise AP) (config-wlan-1# dns-acl {deny, permit} 
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Firmware Management 
 

The running software on the cnPilot Enterprise AP can be upgraded to newer firmware from either the CLI 

or the UI. When upgrading from the CLI the user must specify a TFTP or FTP server from where the firmware 

file would be downloaded by the Access Point. When upgrading from the UI the user can upload the 

firmware file from the browser. The same process can be followed to downgrade the Access Point to a 

previous firmware version if required. Configuration is maintained across the firmware upgrade process. 
 

 

Note 

Once a firmware upgrade has been initiated, the Access Point should not be rebooted 

or power cycled until the process completes, as this might leave the Access Point 

inoperable. 

 

 
You can configure the above parameters through the UI or CLI. 

 

In the UI 

 
5. Navigate to the Operations > Firmware Upgrade tab. The following fields are displayed: 

6. To upgrade the firmware manually: 

Click Browse and select the downloaded image file. 

7. To upgrade the firmware automatically: 

Click Upgrade Firmware. 

8. You can view the status of upgrade in the Upgrade Status field. 

9. Click Save. 

 

Figure 22: Operations: Firmware Upgrade page 
 

 

 

 
In the CLI 

 
To upgrade firmware: 

 
(cnPilot Enterprise AP) (configure)# upgrade 
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System 
 

You can reboot the device, download tech support from the device, and disconnect all the wireless 

clients under the Operations > System page of the UI. 

 
Figure 23: Configure: Operations> Systems page 
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Troubleshooting 
 

The following types of troubleshooting tools are supported: 

 
1. Packet Capture: Allows the administrator to capture all packets on a specified interface. A 

decode of the packet indicating the network addresses, protocol types etc is displayed. The 

administrator can filter the packets being captured by specifying a particular MAC address, 

IP address, port number etc. The number of packets that are captured can also be capped, 

so the console or system is not overwhelmed. Packets captured on the ETH interfaces are 
packets that are being transmitted or received on the physical interface of the device. 

Packets captures on the WLAN interfaces are data packets on a particular WLAN as they 
are bridged on the radio interface of the device. 

 
Figure 24: Troubleshooting> Packet Capture page 

 

 
2. Logs and Events: The system generates event-messages for any notable activity on the 

device from client associations and authentications to system configuration changes. 

These logs are: 

1. Forwarded to cnMaestro for later viewing and filtering 
2. Buffered on the device and can be viewed using ‘show logging’ in the CLI 

3. Transmitted to any configured syslog servers. 
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Figure 25: Logs page 
 

 
3. Configuration Import, Export, Delete: The device configuration can either be exported from 

the device as a text file of CLI commands, or imported into the device from a previous 

backup. The delete configuration option will factory-reset the device. All configuration, 

configured onboarding parameters are reset to default when the configuration is deleted 

and the device rebooted. Note that when a configuration file is imported onto the device, a 

reboot is necessary to activate that new configuration. 

 
Figure 26: Import/Export Configuration 

 
 

 

4. Factory Default: There are two ways a device can be reset back to factory default: 
1. Using the ‘Factory Default’ option in the Operations panel of the GUI or by using 

the ‘delete config’ CLI command. 

 
Figure 27: Factory Default 

 

 
2. By pressing down the reset tab on the Access Point for about 10 seconds 

until the AP reboots (indicated by the power LED changing color from Green to 

Orange). 
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5. Unconnected Clients: Unconnected clients provides a list of clients that could not 

connect properly due to various reasons, with the access points. Currently the following 

failures are tracked: 

 
• Invalid pre-shared key 

• EAP authentication failure 

• Denied due to MAC ACL 

• Radius server not reachable 

• No radius server found 

• Client disconnected by enhanced-roaming 

• Denied association by enhanced-roaming 

 
Use the following CLI to display the list of wireless clients unconnected: 

(cnPilot Enterprise AP) (config# show wireless unconnected clients 
 

Figure 28: Unconnected Clients 
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Legal and Reference Information 
This chapter provides legal notices including software license agreements. 

Intentional or unintentional changes or modifications to the equipment must not be made 

unless under the express consent of the party responsible for compliance. Any such 

modifications could void the user’s authority to operate the equipment and will void the 

manufacturer’s warranty. 
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Cambium Networks End User License Agreement 

ACCEPTANCE OF THIS AGREEMENT 

In connection with Cambium Networks’ delivery of certain proprietary software or products 

containing embedded or pre-loaded proprietary software, or both, Cambium Networks is willing to 

license this certain proprietary software and the accompanying documentation to you only on the 

condition that you accept all the terms in this End User License Agreement (“Agreement”). 

IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THE PRODUCT OR 

INSTALL THE SOFTWARE. INSTEAD, YOU MAY, FOR A FULL REFUND, RETURN THIS PRODUCT 

TO THE LOCATION WHERE YOU ACQUIRED IT OR PROVIDE WRITTEN VERIFICATION OF 

DELETION OF ALL COPIES OF THE SOFTWARE. ANY USE OF THE SOFTWARE, INCLUDING BUT 

NOT LIMITED TO USE ON THE PRODUCT, WILL CONSTITUTE YOUR ACCEPTANCE TO THE 

TERMS OF THIS AGREEMENT. 

DEFINITIONS 

In this Agreement, the word “Software” refers to the set of instructions for computers, in 

executable form and in any media, (which may include diskette, CD-ROM, downloadable internet, 

hardware, or firmware) licensed to you. The word “Documentation” refers to electronic or printed 

manuals and accompanying instructional aids licensed to you. The word “Product” refers to 

Cambium Networks’ fixed wireless broadband devices for which the Software and Documentation 

is licensed for use. 

GRANT OF LICENSE 

Cambium Networks Limited (“Cambium”) grants you (“Licensee” or “you”) a personal, 

nonexclusive, non-transferable license to use the Software and Documentation subject to the 

Conditions of Use set forth in “Conditions of use” and the terms and conditions of this Agreement. 

Any terms or conditions relating to the Software and Documentation appearing on the face or 

reverse side of any purchase order, purchase order acknowledgment or other order document that 

are different from, or in addition to, the terms of this Agreement will not be binding on the parties, 

even if payment is accepted. 

CONDITIONS OF USE 

Any use of the Software and Documentation outside of the conditions set forth in this Agreement 

is strictly prohibited and will be deemed a breach of this Agreement. 

1. Only you, your employees or agents may use the Software and Documentation. You will take all 

necessary steps to insure that your employees and agents abide by the terms of this Agreement. 

2. You will use the Software and Documentation (i) only for your internal business purposes; (ii) 

only as described in the Software and Documentation; and (iii) in strict accordance with this 

Agreement. 

3. You may use the Software and Documentation, provided that the use is in conformance with the 

terms set forth in this Agreement. 
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4. Portions of the Software and Documentation are protected by United States copyright laws, 

international treaty provisions, and other applicable laws. Therefore, you must treat the Software 

like any other copyrighted material (for example, a book or musical recording) except that you may 

either: (i) make 1 copy of the transportable part of the Software (which typically is supplied on 

diskette, CD-ROM, or downloadable internet), solely for back-up purposes; or (ii) copy the 

transportable part of the Software to a PC hard disk, provided you keep the original solely for back- 

up purposes. If the Documentation is in printed form, it may not be copied. If the Documentation 

is in electronic form, you may print out 1 copy, which then may not be copied. With regard to the 

copy made for backup or archival purposes, you agree to reproduce any Cambium Networks 

copyright notice, and other proprietary legends appearing thereon. Such copyright notice(s) may 

appear in any of several forms, including machine-readable form, and you agree to reproduce  

such notice in each form in which it appears, to the extent it is physically possible to do so. 

Unauthorized duplication of the Software or Documentation constitutes copyright infringement, 

and in the United States is punishable in federal court by fine and imprisonment. 

5. You will not transfer, directly or indirectly, any product, technical data or software to any 

country for which the United States Government requires an export license or other governmental 

approval without first obtaining such license or approval. 

TITLE AND RESTRICTIONS 

If you transfer possession of any copy of the Software and Documentation to another party outside 

of the terms of this agreement, your license is automatically terminated. Title and copyrights to 

the Software and Documentation and any copies made by you remain with Cambium Networks  

and its licensors. You will not, and will not permit others to: (i) modify, translate, decompile, 

bootleg, reverse engineer, disassemble, or extract the inner workings of the Software or 

Documentation, (ii) copy the look-and-feel or functionality of the Software or Documentation; 

(iii) remove any proprietary notices, marks, labels, or logos from the Software or Documentation; 

(iv) rent or transfer all or some of the Software or Documentation to any other party without 

Cambium’s prior written consent; or (v) utilize any computer software or hardware which is 

designed to defeat any copy protection device, should the Software and Documentation be 

equipped with such a protection device. If the Software and Documentation is provided on 

multiple types of media (such as diskette, CD-ROM, downloadable internet), then you will only use 

the medium which best meets your specific needs, and will not loan, rent, lease, or transfer the 

other media contained in the package without Cambium’s written consent. Unauthorized copying 

of the Software or Documentation, or failure to comply with any of the provisions of this 

Agreement, will result in automatic termination of this license. 
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CONFIDENTIALITY 

You acknowledge that all Software and Documentation contain valuable proprietary information 

and trade secrets and that unauthorized or improper use of the Software and Documentation will 

result in irreparable harm to Cambium Networks for which monetary damages would be 

inadequate and for which Cambium Networks will be entitled to immediate injunctive relief. If 

applicable, you will limit access to the Software and Documentation to those of your employees 

and agents who need to use the Software and Documentation for your internal business purposes, 

and you will take appropriate action with those employees and agents to preserve the 

confidentiality of the Software and Documentation, using the same degree of care to avoid 

unauthorized or improper disclosure as you use for the protection of your own proprietary 

software, but in no event less than reasonable care. 

You have no obligation to preserve the confidentiality of any proprietary information that: (i) was 

in the public domain at the time of disclosure; (ii) entered the public domain through no fault of 

yours; (iii) was given to you free of any obligation to keep it confidential; (iv) is independently 

developed by you; or (v) is disclosed as required by law provided that you notify Cambium 

Networks prior to such disclosure and provide Cambium Networks with a reasonable opportunity 

to respond. 

RIGHT TO USE CAMBIUM’S NAME 

Except as required in “Conditions of use”, you will not, during the term of this Agreement or 

thereafter, use any trademark of Cambium Networks, or any word or symbol likely to be confused 

with any Cambium Networks trademark, either alone or in any combination with another word or 

words. 

TRANSFER 

The Software and Documentation may not be transferred to another party without the express 

written consent of Cambium Networks, regardless of whether or not such transfer is accomplished 

by physical or electronic means. Cambium’s consent may be withheld at its discretion and may be 

conditioned upon transferee paying all applicable license fees and agreeing to be bound by this 

Agreement. 

UPDATES 

During the first 12 months after purchase of a Product, or during the term of any executed 

Maintenance and Support Agreement for the Product, you are entitled to receive Updates. An 

“Update” means any code in any form which is a bug fix, patch, error correction, or minor 

enhancement, but excludes any major feature added to the Software. Updates are available for 

download at the support website. 

Major features may be available from time to time for an additional license fee. If Cambium 

Networks makes available to you major features and no other end user license agreement is 

provided, then the terms of this Agreement will apply. 

MAINTENANCE 

Except as provided above, Cambium Networks is not responsible for maintenance or field service 

of the Software under this Agreement. 
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DISCLAIMER 

CAMBIUM NETWORKS DISCLAIMS ALL WARRANTIES OF ANY KIND, WHETHER EXPRESS, 

IMPLIED, STATUTORY, OR IN ANY COMMUNICATION WITH YOU. CAMBIUM NETWORKS 

SPECIFICALLY DISCLAIMS ANY WARRANTY INCLUDING THE IMPLIED WARRANTIES OF 

MERCHANTABILTY, NONINFRINGEMENT, OR FITNESS FOR A PARTICULAR PURPOSE. THE 

SOFTWARE AND DOCUMENTATION ARE PROVIDED “AS IS.” CAMBIUM NETWORKS DOES NOT 

WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION 

OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT DEFECTS IN THE 

SOFTWARE WILL BE CORRECTED. CAMBIUM NETWORKS MAKES NO WARRANTY WITH 

RESPECT TO THE CORRECTNESS, ACCURACY, OR RELIABILITY OF THE SOFTWARE AND 

DOCUMENTATION. Some jurisdictions do not allow the exclusion of implied warranties, so the 

above exclusion may not apply to you. 

LIMITATION OF LIABILITY 

IN NO EVENT SHALL CAMBIUM NETWORKS BE LIABLE TO YOU OR ANY OTHER PARTY FOR ANY 

DIRECT, INDIRECT, GENERAL, SPECIAL, INCIDENTAL, CONSEQUENTIAL, EXEMPLARY OR OTHER 

DAMAGE ARISING OUT OF THE USE OR INABILITY TO USE THE PRODUCT (INCLUDING, 

WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS  

INTERRUPTION, LOSS OF BUSINESS INFORMATION OR ANY OTHER PECUNIARY LOSS, OR 

FROM ANY BREACH OF WARRANTY, EVEN IF CAMBIUM NETWORKS HAS BEEN ADVISED OF 

THE POSSIBILITY OF SUCH DAMAGES. (Some states do not allow the exclusion or limitation of 

incidental or consequential damages, so the above exclusion or limitation may not apply to you.) 

IN NO CASE SHALL CAMBIUM’S LIABILITY EXCEED THE AMOUNT YOU PAID FOR THE PRODUCT. 

U.S. GOVERNMENT 

If you are acquiring the Product on behalf of any unit or agency of the U.S. Government, the 

following applies. Use, duplication, or disclosure of the Software and Documentation is subject to 

the restrictions set forth in subparagraphs (c) (1) and (2) of the Commercial Computer Software – 

Restricted Rights clause at FAR 52.227-19 (JUNE 1987), if applicable, unless being provided to the 

Department of Defense. If being provided to the Department of Defense, use, duplication, or 

disclosure of the Products is subject to the restricted rights set forth in subparagraph (c) (1) (ii) of 

the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 (OCT 1988), if 

applicable. Software and Documentation may or may not include a Restricted Rights notice, or 

other notice referring specifically to the terms and conditions of this Agreement. The terms and 

conditions of this Agreement will each continue to apply, but only to the extent that such terms 

and conditions are not inconsistent with the rights provided to you under the aforementioned 

provisions of the FAR and DFARS, as applicable to the particular procuring agency and 

procurement transaction. 
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TERM OF LICENSE 

Your right to use the Software will continue in perpetuity unless terminated as follows. Your right 

to use the Software will terminate immediately without notice upon a breach of this Agreement by 

you. Within 30 days after termination of this Agreement, you will certify to Cambium Networks in 

writing that through your best efforts, and to the best of your knowledge, the original and all 

copies, in whole or in part, in any form, of the Software and all related material and 

Documentation, have been destroyed, except that, with prior written consent from Cambium 

Networks, you may retain one copy for archival or backup purposes. You may not sublicense, 

assign or transfer the license or the Product, except as expressly provided in this Agreement. Any 

attempt to otherwise sublicense, assign or transfer any of the rights, duties or obligations 

hereunder is null and void. 

GOVERNING LAW 

This Agreement is governed by the laws of the United States of America to the extent that they 

apply and otherwise by the laws of the State of Illinois. 

ASSIGNMENT 

This agreement may not be assigned by you without Cambium’s prior written consent. 

SURVIVAL OF PROVISIONS 

The parties agree that where the context of any provision indicates an intent that it survives the 

term of this Agreement, then it will survive. 

ENTIRE AGREEMENT 

This agreement contains the parties’ entire agreement regarding your use of the Software and 

may be amended only in writing signed by both parties, except that Cambium Networks may 

modify this Agreement as necessary to comply with applicable laws. 

THIRD PARTY SOFTWARE 

The software may contain one or more items of Third-Party Software supplied by other third-party 

suppliers. The terms of this Agreement govern your use of any Third-Party Software UNLESS A 

SEPARATE THIRD-PARTY SOFTWARE LICENSE IS INCLUDED, IN WHICH CASE YOUR USE OF THE 

THIRD-PARTY SOFTWARE WILL THEN BE GOVERNED BY THE SEPARATE THIRD-PARTY LICENSE. 
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Aquila 

 

 
Copyright (c) 2002-2010, Atheros Communications Inc. 

Copyright (c) 2002-2005 Sam Leffler, Errno Consulting 

Copyright (C) 2011 Denali Software Inc. All rights reserved 

 

Permission to use, copy, modify, and/or distribute this software for any 

purpose with or without fee is hereby granted, provided that the above 

copyright notice and this permission notice appear in all copies. 

 

THE SOFTWARE IS PROVIDED "AS IS" AND THE AUTHOR DISCLAIMS ALL 

WARRANTIES 

WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES 

OF 

MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL THE AUTHOR BE 

LIABLE FOR 

ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY 

DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 

WHETHER IN AN 

ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, 

ARISING OUT OF 

OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 

SOFTWARE. 

 
================================================== 

 
Redistribution and use in source and binary forms are permitted 

provided that the following conditions are met: 

1. The materials contained herein are unmodified and are used 

unmodified. 

2. Redistributions of source code must retain the above copyright 

notice, this list of conditions and the following NO 

''WARRANTY'' disclaimer below (''Disclaimer''), without 

modification. 

3. Redistributions in binary form must reproduce at minimum a 

disclaimer similar to the Disclaimer below and any redistribution 

must be conditioned upon including a substantially similar 

Disclaimer requirement for further binary redistribution. 

4. Neither the names of the above-listed copyright holders nor the 

names of any contributors may be used to endorse or promote 

product derived from this software without specific prior written 

permission. 

 
NO WARRANTY 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 

CONTRIBUTORS ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
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NONINFRINGEMENT,MERCHANTIBILITY AND FITNESS FOR A PARTICULAR 

PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT 

HOLDERS OR CONTRIBUTORS BE LIABLE FOR SPECIAL, EXEMPLARY, OR 

CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 

AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 

LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 

ANY WAY OUT 

OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY 

OF 

SUCH DAMAGES. 

  
Linux Kernel 

Copyright (c) 1989, 1991 Free Software Foundation 

 

NOTE! This copyright does *not* cover user programs that use kernel 
services by normal system calls - this is merely considered normal use 
of the kernel, and does *not* fall under the heading of "derived work". 
Also note that the GPL below is copyrighted by the Free Software 
Foundation, but the instance of code that it refers to (the Linux 
kernel) is copyrighted by me and others who actually wrote it. 

 
Also note that the only valid version of the GPL as far as the kernel 
is concerned is _this_ particular version of the license (ie v2, not 
v2.2 or v3.x or whatever), unless explicitly otherwise stated. 

 
Linus Torvalds 

 
---------------------------------------- 

 
GNU GENERAL PUBLIC LICENSE 
Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA 
Everyone is permitted to copy and distribute verbatim copies 
of this license document, but changing it is not allowed. 

 
See above for details of the license. 
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gpio_keys 

 

 
/* 

* Driver for keys on GPIO lines capable of generating interrupts. 

* 

* Copyright 2005 Phil Blundell 

* 

* This program is free software; you can redistribute it and/or modify 

* it under the terms of the GNU General Public License version 2 as 

* published by the Free Software Foundation. 

*/ 

 

  
uboot 

Copyright (c) 2007 Wolfgan Denk, DENIX Software Engeneering, 

wd@denix.de 

# (C) Copyright 2000 - 2005 

# Wolfgang Denk, DENX Software Engineering, wd@denx.de. 

# 

# See file CREDITS for list of people who contributed to this 

# project. 

# 

# This program is free software; you can redistribute it and/or 

# modify it under the terms of the GNU General Public License as 

# published by the Free Software Foundation; either version 2 of 

# the License, or (at your option) any later version. 

# 

# This program is distributed in the hope that it will be useful, 

# but WITHOUT ANY WARRANTY; without even the implied warranty of 

# MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the 

# GNU General Public License for more details. 

# 

# You should have received a copy of the GNU General Public License 

# along with this program; if not, write to the Free Software 

# Foundation, Inc., 59 Temple Place, Suite 330, Boston, 

# MA 02111-1307 USA 

See above for details of the license. 
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busybox 

 

 
--- A note on GPL versions 

 
BusyBox is distributed under version 2 of the General Public License 

(included in its entirety, below). Version 2 is the only version of this license 

which this version of BusyBox (or modified versions derived from this one) 

may be distributed under. 

 

------------------------------------------------------------------------ 

GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 
Preamble 

 
The licenses for most software are designed to take away your freedom to 

share and change it. By contrast, the GNU General Public License is intended 

to guarantee your freedom to share and change free software--to make sure 

the software is free for all its users. This General Public License applies to 

most of the Free Software Foundation's software and to any other program 

whose authors commit to using it. (Some other Free Software Foundation 

software is covered by the GNU Lesser General Public License instead.) You 

can apply it to your programs, too. 

 
When we speak of free software, we are referring to freedom, not price. Our 

General Public Licenses are designed to make sure that you have the 

freedom to distribute copies of free software (and charge for this service if 

you wish), that you receive source code or can get it if you want it, that you 

can change the software or use pieces of it in new free programs; and that 

you know you can do these things. 

 
To protect your rights, we need to make restrictions that forbid anyone to 

deny you these rights or to ask you to surrender the rights. These restrictions 

translate to certain responsibilities for you if you distribute copies of the 

software, or if you modify it. 

 
For example, if you distribute copies of such a program, whether gratis or for 

a fee, you must give the recipients all the rights that you have. You must 

make sure that they, too, receive or can get the source code. And you must 

show them these terms so they know their rights. 
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We protect your rights with two steps: (1) copyright the software, and (2) 

offer you this license which gives you legal permission to copy, distribute 

and/or modify the software. 

 
Also, for each author's protection and ours, we want to make certain that 

everyone understands that there is no warranty for this free software. If the 

software is modified by someone else and passed on, we want its recipients 

to know that what they have is not the original, so that any problems 

introduced by others will not reflect on the original authors' reputations. 

 
Finally, any free program is threatened constantly by software patents. We 

wish to avoid the danger that redistributors of a free program will 

individually obtain patent licenses, in effect making the program proprietary. 

To prevent this, we have made it clear that any patent must be licensed for 

everyone's free use or not licensed at all. 

 
The precise terms and conditions for copying, distribution and modification 

follow. 

 
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND 

MODIFICATION 

0. This License applies to any program or other work which contains a notice 

placed by the copyright holder saying it may be distributed under the terms 

of this General Public License. The "Program", below, refers to any such 

program or work, and a "work based on the Program" means either the 

Program or any derivative work under copyright law: that is to say, a work 

containing the Program or a portion of it, either verbatim or with 

modifications and/or translated into another language. (Hereinafter, 

translation is included without limitation in the term "modification".) Each 

licensee is addressed as "you". 

 
Activities other than copying, distribution and modification are not covered 

by this License; they are outside its scope. The act of running the Program is 

not restricted, and the output from the Program is covered only if its contents 

constitute a work based on the Program (independent of having been made 

by running the Program). Whether that is true depends on what the Program 

does. 

 
1. You may copy and distribute verbatim copies of the Program's source 

code as you receive it, in any medium, provided that you conspicuously and 

appropriately publish on each copy an appropriate copyright notice and 
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disclaimer of warranty; keep intact all the notices that refer to this License 

and to the absence of any warranty; and give any other recipients of the 

Program a copy of this License along with the Program. 

 
You may charge a fee for the physical act of transferring a copy, and you may 

at your option offer warranty protection in exchange for a fee. 

 
2. You may modify your copy or copies of the Program or any portion of it, 

thus forming a work based on the Program, and copy and distribute such 

modifications or work under the terms of Section 1 above, provided that you 

also meet all of these conditions: 

 
a) You must cause the modified files to carry prominent notices 

stating that you changed the files and the date of any change. 

 

b) You must cause any work that you distribute or publish, that in 

whole or in part contains or is derived from the Program or any 

part thereof, to be licensed as a whole at no charge to all third 

parties under the terms of this License. 

 

c) If the modified program normally reads commands interactively 

when run, you must cause it, when started running for such 

interactive use in the most ordinary way, to print or display an 

announcement including an appropriate copyright notice and a 

notice that there is no warranty (or else, saying that you provide a 

warranty) and that users may redistribute the program under these 

conditions, and telling the user how to view a copy of this License. 

(Exception: if the Program itself is interactive but does not normally 

print such an announcement, your work based on the Program is 

not required to print an announcement.) 

 

These requirements apply to the modified work as a whole. If identifiable 

sections of that work are not derived from the Program, and can be 

reasonably considered independent and separate works in themselves, then 

this License, and its terms, do not apply to those sections when you 

distribute them as separate works. But when you distribute the same sections 

as part of a whole which is a work based on the Program, the distribution of 

the whole must be on the terms of this License, whose permissions for other 
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licensees extend to the entire whole, and thus to each and every part 

regardless of who wrote it. 

 
Thus, it is not the intent of this section to claim rights or contest your rights 

to work written entirely by you; rather, the intent is to exercise the right to 

control the distribution of derivative or collective works based on the 

Program. 

 
In addition, mere aggregation of another work not based on the Program 

with the Program (or with a work based on the Program) on a volume of a 

storage or distribution medium does not bring the other work under the 

scope of this License. 

 
3. You may copy and distribute the Program (or a work based on it, under 

Section 2) in object code or executable form under the terms of Sections 1 

and 2 above provided that you also do one of the following: 

 
a) Accompany it with the complete corresponding machine- 

readable source code, which must be distributed under the terms 

of Sections 1 and 2 above on a medium customarily used for 

software interchange; or, 

 

b) Accompany it with a written offer, valid for at least three years, 

to give any third party, for a charge no more than your cost of 

physically performing source distribution, a complete machine- 

readable copy of the corresponding source code, to be distributed 

under the terms of Sections 1 and 2 above on a medium 

customarily used for software interchange; or, 

 

c) Accompany it with the information you received as to the offer 

to distribute corresponding source code. (This alternative is 

allowed only for noncommercial distribution and only if you 

received the program in object code or executable form with such 

an offer, in accord with Subsection b above.) 

 

The source code for a work means the preferred form of the work for making 

modifications to it. For an executable work, complete source code means all 

the source code for all modules it contains, plus any associated interface 

definition files, plus the scripts used to control compilation and installation of 

the executable. However, as a special exception, the source code distributed 
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need not include anything that is normally distributed (in either source or 

binary form) with the major components (compiler, kernel, and so on) of the 

operating system on which the executable runs, unless that component itself 

accompanies the executable. 

 
If distribution of executable or object code is made by offering access to copy 

from a designated place, then offering equivalent access to copy the source 

code from the same place counts as distribution of the source code, even 

though third parties are not compelled to copy the source along with the 

object code. 

 
4. You may not copy, modify, sublicense, or distribute the Program except as 

expressly provided under this License. Any attempt otherwise to copy, 

modify, sublicense or distribute the Program is void, and will automatically 

terminate your rights under this License. However, parties who have received 

copies, or rights, from you under this License will not have their licenses 

terminated so long as such parties remain in full compliance. 

 
5. You are not required to accept this License, since you have not signed it. 

However, nothing else grants you permission to modify or distribute the 

Program or its derivative works. These actions are prohibited by law if you do 

not accept this License. Therefore, by modifying or distributing the Program 

(or any work based on the Program), you indicate your acceptance of this 

License to do so, and all its terms and conditions for copying, distributing or 

modifying the Program or works based on it. 

 
6. Each time you redistribute the Program (or any work based on the 

Program), the recipient automatically receives a license from the original 

licensor to copy, distribute or modify the Program subject to these terms and 

conditions. You may not impose any further restrictions on the recipients' 

exercise of the rights granted herein. You are not responsible for enforcing 

compliance by third parties to this License. 

 
7. If, as a consequence of a court judgment or allegation of patent 

infringement or for any other reason (not limited to patent issues), conditions 

are imposed on you (whether by court order, agreement or otherwise) that 

contradict the conditions of this License, they do not excuse you from the 

conditions of this License. If you cannot distribute so as to satisfy 

simultaneously your obligations under this License and any other pertinent 

obligations, then as a consequence you may not distribute the Program at all. 

For example, if a patent license would not permit royalty-free redistribution 

of the Program by all those who receive copies directly or indirectly through 
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you, then the only way you could satisfy both it and this License would be to 

refrain entirely from distribution of the Program. 

 
If any portion of this section is held invalid or unenforceable under any 

particular circumstance, the balance of the section is intended to apply and 

the section as a whole is intended to apply in other circumstances. 

 
It is not the purpose of this section to induce you to infringe any patents or 

other property right claims or to contest validity of any such claims; this 

section has the sole purpose of protecting the integrity of the free software 

distribution system, which is implemented by public license practices. Many 

people have made generous contributions to the wide range of software 

distributed through that system in reliance on consistent application of that 

system; it is up to the author/donor to decide if he or she is willing to 

distribute software through any other system and a licensee cannot impose 

that choice. 

 
This section is intended to make thoroughly clear what is believed to be a 

consequence of the rest of this License. 

 
8. If the distribution and/or use of the Program is restricted in certain 

countries either by patents or by copyrighted interfaces, the original 

copyright holder who places the Program under this License may add an 

explicit geographical distribution limitation excluding those countries, so that 

distribution is permitted only in or among countries not thus excluded. In 

such case, this License incorporates the limitation as if written in the body of 

this License. 

 
9. The Free Software Foundation may publish revised and/or new versions of 

the General Public License from time to time. Such new versions will be 

similar in spirit to the present version, but may differ in detail to address new 

problems or concerns. 

 
Each version is given a distinguishing version number. If the Program 

specifies a version number of this License which applies to it and "any later 

version", you have the option of following the terms and conditions either of 

that version or of any later version published by the Free Software 

Foundation. If the Program does not specify a version number of this License, 

you may choose any version ever published by the Free Software 

Foundation. 

 
10. If you wish to incorporate parts of the Program into other free programs 

whose distribution conditions are different, write to the author to ask for 
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permission. For software which is copyrighted by the Free Software 

Foundation, write to the Free Software Foundation; we sometimes make 

exceptions for this. Our decision will be guided by the two goals of 

preserving the free status of all derivatives of our free software and of 

promoting the sharing and reuse of software generally. 

 
NO WARRANTY 

 
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY 

APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE 

COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 

"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 

IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE 

ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM 

IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME 

THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

 
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO 

IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO 

MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED 

ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 

SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 

THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT 

LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR 

LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE 

PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH 

HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF 

SUCH DAMAGES. 

 
END OF TERMS AND CONDITIONS 

  
dnsmasq 

# This program is free software; you can redistribute it and/or modify 

# it under the terms of the GNU General Public License as published by 

# the Free Software Foundation; version 2 dated June, 1991, or 

# (at your option) version 3 dated 29 June, 2007. 

See above for details of the license. 
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dropbear 

 

 
Dropbear contains a number of components from different sources, hence 

there are a few licenses and authors involved. All licenses are fairly non- 

restrictive. 

 

The majority of code is written by Matt Johnston, under the license below. 
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Portions of the client-mode work are (c) 2004 Mihnea Stoenescu, under the 

same license: 

 
Copyright (c) 2002-2008 Matt Johnston 

Portions copyright (c) 2004 Mihnea Stoenescu 

All rights reserved. 

 
Permission is hereby granted, free of charge, to any person obtaining a copy 

of this software and associated documentation files (the "Software"), to deal 

in the Software without restriction, including without limitation the rights to 

use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies 

of the Software, and to permit persons to whom the Software is furnished to 

do so, subject to the following conditions: 

 
The above copyright notice and this permission notice shall be included in all 

copies or substantial portions of the Software. 

 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 

OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT 

HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, 

WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 

OTHER DEALINGS IN THE SOFTWARE. 

 
===== 

 
LibTomCrypt and LibTomMath are written by Tom St Denis, and are Public 

Domain. 

 
===== 

 
sshpty.c is taken from OpenSSH 3.5p1, 

Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland 

All rights reserved 

"As far as I am concerned, the code I have written for this software 

can be used freely for any purpose. Any derived versions of this 

software must be clearly marked as such, and if the derived work is 

incompatible with the protocol description in the RFC file, it must be 

called by a name other than "ssh" or "Secure Shell". " 

 
===== 

 
loginrec.c 

loginrec.h 
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atomicio.h 

atomicio.c 

and strlcat() (included in util.c) are from OpenSSH 3.6.1p2, and are licensed 

under the 2 point BSD license. 

 
loginrec is written primarily by Andre Lucas, atomicio.c by Theo de Raadt. 

strlcat() is (c) Todd C. Miller 

===== 

 
Import code in keyimport.c is modified from PuTTY's import.c, licensed as 

follows: 

 
PuTTY is copyright 1997-2003 Simon Tatham. 

 
Portions copyright Robert de Bath, Joris van Rantwijk, Delian 

Delchev, Andreas Schultz, Jeroen Massar, Wez Furlong, Nicolas Barry, 

Justin Bradford, and CORE SDI S.A. 

 
Permission is hereby granted, free of charge, to any person 

obtaining a copy of this software and associated documentation files 

(the "Software"), to deal in the Software without restriction, 

including without limitation the rights to use, copy, modify, merge, 

publish, distribute, sublicense, and/or sell copies of the Software, 

and to permit persons to whom the Software is furnished to do so, 

subject to the following conditions: 

 
The above copyright notice and this permission notice shall be 

included in all copies or substantial portions of the Software. 

 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 

EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES 

OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS BE 

LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 

ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR 

IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS 

IN THE SOFTWARE. 
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hostapd 
Copyright (c) 2002-2011, Jouni Malinen <j@w1.fi> and contributors 

All Rights Reserved. 

 

These programs are dual-licensed under both the GPL version 2 and BSD 

license (the one with advertisement clause removed). Either license 

may be used at your option. 

 
This package may include either wpa_supplicant, hostapd, or both. See 

README file respective subdirectories (wpa_supplicant/README or 

hostapd/README) for more details. 

See above for details of the license. 

 

iproute2 
GNU GENERAL PUBLIC LICENSE 
Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA 
Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 
 

See above for details of the license. 

 

iptables 
GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

675 Mass Ave, Cambridge, MA 02139, USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

See above for details of the license. 
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Openssl 
LICENSE ISSUES 
============== 

 
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of 
the OpenSSL License and the original SSLeay license apply to the toolkit. 

See below for the actual license texts. Actually both licenses are BSD-style 
Open Source licenses. In case of any license issues related to OpenSSL 

please contact openssl-core@openssl.org. 

 
OpenSSL License 
--------------- 

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved. 

 
Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

 
1. Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

3. All advertising materials mentioning features or use of this software must 

display the following acknowledgment: "This product includes software 

developed by the OpenSSL Project for use in the OpenSSL Toolkit. 

(http://www.openssl.org/)" 

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to 
endorse or promote products derived from this software without prior 

written permission. For written permission, please contact openssl- 

core@openssl.org. 

5. Products derived from this software may not be called "OpenSSL" 
nor may "OpenSSL" appear in their names without prior written 
permission of the OpenSSL Project. 
6. Redistributions of any form whatsoever must retain the following 
acknowledgment: "This product includes software developed by the 
OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)" 
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND   
ANY EXPRESSED OR IMPLIED  WARRANTIES,  INCLUDING,  BUT  NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND  
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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c-ares 
Copyright 1998 by the Massachusetts Institute of Technology. 
 
Permission to use, copy, modify, and distribute this software and its 

documentation for any purpose and without fee is hereby granted, provided 

that the above copyright notice appear in all copies and that both that 

copyright notice and this permission notice appear in supporting 

documentation, and that the name of M.I.T. not be used in advertising or 
publicity pertaining to distribution of the software without specific, written 

prior permission. 

M.I.T. makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

lighttpd 
Copyright (c) 2004, Jan Kneschke, incremental 
All rights reserved. 

 
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met: 

 
- Redistributions of source code must retain the above copyright notice, this 

list of conditions and the following disclaimer. 

 
- Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation 

and/or other materials provided with the distribution. 

 
- Neither the name of the 'incremental' nor the names of its contributors may 

be used to endorse or promote products derived from this software without 
specific prior written permission. 

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 



8

5 

cnPilot Enterprise AP User Guide CAMBIUM NETWORKS 
 

 

 
 

libnl GNU LESSER GENERAL PUBLIC LICENSE 
Version 2.1, February 1999 

 
Copyright (C) 1991, 1999 Free Software Foundation, Inc. 
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 
[This is the first released version of the Lesser GPL. It also counts 
as the successor of the GNU Library Public License, version 2, hence 

the version number 2.1.] 

 
Preamble 

 
The licenses for most software are designed to take away your 

freedom to share and change it. By contrast, the GNU General Public 
Licenses are intended to guarantee your freedom to share and change 

free software--to make sure the software is free for all its users. 

 
This license, the Lesser General Public License, applies to some 

specially designated software packages--typically libraries--of the 

Free Software Foundation and other authors who decide to use it. You 

can use it too, but we suggest you first think carefully about whether 

this license or the ordinary General Public License is the better 

strategy to use in any particular case, based on the explanations below. 

 
When we speak of free software, we are referring to freedom of use, 

not price. Our General Public Licenses are designed to make sure that 

you have the freedom to distribute copies of free software (and charge 

for this service if you wish); that you receive source code or can get 

it if you want it; that you can change the software and use pieces of 

it in new free programs; and that you are informed that you can do 

these things. 

 
To protect your rights, we need to make restrictions that forbid 

distributors to deny you these rights or to ask you to surrender these 
rights. These restrictions translate to certain responsibilities for 

you if you distribute copies of the library or if you modify it. 

 
For example, if you distribute copies of the library, whether gratis 

or for a fee, you must give the recipients all the rights that we gave 

you. You must make sure that they, too, receive or can get the source 

code. If you link other code with the library, you must provide 

complete object files to the recipients, so that they can relink them 

with the library after making changes to the library and recompiling 
it. And you must show them these terms so they know their rights. 

 
We protect your rights with a two-step method: (1) we copyright the 

library, and (2) we offer you this license, which gives you legal 

permission to copy, distribute and/or modify the library. 

 
To protect each distributor, we want to make it very clear that 

there is no warranty for the free library. Also, if the library is 
modified by someone else and passed on, the recipients should know 
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 that what they have is not the original version, so that the original 

author's reputation will not be affected by problems that might be 

introduced by others. 

 
Finally, software patents pose a constant threat to the existence of 

any free program. We wish to make sure that a company cannot 

effectively restrict the users of a free program by obtaining a 
restrictive license from a patent holder. Therefore, we insist that 

any patent license obtained for a version of the library must be 
consistent with the full freedom of use specified in this license. 

 
Most GNU software, including some libraries, is covered by the 

ordinary GNU General Public License. This license, the GNU Lesser 

General Public License, applies to certain designated libraries, and 

is quite different from the ordinary General Public License. We use 
this license for certain libraries in order to permit linking those 

libraries into non-free programs. 

 
When a program is linked with a library, whether statically or using 

a shared library, the combination of the two is legally speaking a 

combined work, a derivative of the original library. The ordinary 

General Public License therefore permits such linking only if the 

entire combination fits its criteria of freedom. The Lesser General 

Public License permits more lax criteria for linking other code with 
the library. 

 
We call this license the "Lesser" General Public License because it 

does Less to protect the user's freedom than the ordinary General 

Public License. It also provides other free software developers Less 

of an advantage over competing non-free programs. These disadvantages 

are the reason we use the ordinary General Public License for many 

libraries. However, the Lesser license provides advantages in certain 

special circumstances. 

 
For example, on rare occasions, there may be a special need to 

encourage the widest possible use of a certain library, so that it becomes 

a de-facto standard. To achieve this, non-free programs must be 

allowed to use the library. A more frequent case is that a free 

library does the same job as widely used non-free libraries. In this 
case, there is little to gain by limiting the free library to free 

software only, so we use the Lesser General Public License. 

 
In other cases, permission to use a particular library in non-free 

programs enables a greater number of people to use a large body of 
free software. For example, permission to use the GNU C Library in 

non-free programs enables many more people to use the whole GNU 

operating system, as well as its variant, the GNU/Linux operating 
system. 

 
Although the Lesser General Public License is Less protective of the 

users' freedom, it does ensure that the user of a program that is 
linked with the Library has the freedom and the wherewithal to run 

that program using a modified version of the Library. 
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 The precise terms and conditions for copying, distribution and 

modification follow. Pay close attention to the difference between a 

"work based on the library" and a "work that uses the library". The 

former contains code derived from the library, whereas the latter must 
be combined with the library in order to run. 

bridge-utils GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

See above for details of the license. 

jansson Copyright (c) 2009-2013 Petri Lehtinen <petri@digip.org> 

 
Permission is hereby granted, free of charge, to any person obtaining a copy 
of this software and associated documentation files (the "Software"), to deal 

in the Software without restriction, including without limitation the rights 
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 

copies of the Software, and to permit persons to whom the Software is 

furnished to do so, subject to the following conditions: 

 
The above copyright notice and this permission notice shall be included in 

all copies or substantial portions of the Software. 

 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN 
THE SOFTWARE. 
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libnl GNU LESSER GENERAL PUBLIC LICENSE 
Version 2.1, February 1999 

 
Copyright (C) 1991, 1999 Free Software Foundation, Inc. 
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 
[This is the first released version of the Lesser GPL. It also counts 
as the successor of the GNU Library Public License, version 2, hence 

the version number 2.1.] 

 
Preamble 

 
The licenses for most software are designed to take away your 

freedom to share and change it. By contrast, the GNU General Public 
Licenses are intended to guarantee your freedom to share and change 

free software--to make sure the software is free for all its users. 

 
This license, the Lesser General Public License, applies to some 

specially designated software packages--typically libraries--of the 

Free Software Foundation and other authors who decide to use it. You 

can use it too, but we suggest you first think carefully about whether 

this license or the ordinary General Public License is the better 

strategy to use in any particular case, based on the explanations below. 

 
When we speak of free software, we are referring to freedom of use, 

not price. Our General Public Licenses are designed to make sure that 

you have the freedom to distribute copies of free software (and charge 

for this service if you wish); that you receive source code or can get 

it if you want it; that you can change the software and use pieces of 

it in new free programs; and that you are informed that you can do 

these things. 

 
To protect your rights, we need to make restrictions that forbid 

distributors to deny you these rights or to ask you to surrender these 
rights. These restrictions translate to certain responsibilities for 

you if you distribute copies of the library or if you modify it. 

 
For example, if you distribute copies of the library, whether gratis 

or for a fee, you must give the recipients all the rights that we gave 

you. You must make sure that they, too, receive or can get the source 

code. If you link other code with the library, you must provide 

complete object files to the recipients, so that they can relink them 

with the library after making changes to the library and recompiling 
it. And you must show them these terms so they know their rights. 

 
We protect your rights with a two-step method: (1) we copyright the 

library, and (2) we offer you this license, which gives you legal 

permission to copy, distribute and/or modify the library. 

 
To protect each distributor, we want to make it very clear that 

there is no warranty for the free library. Also, if the library is 
modified by someone else and passed on, the recipients should know 
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 that what they have is not the original version, so that the original 

author's reputation will not be affected by problems that might be 

introduced by others. 

 
Finally, software patents pose a constant threat to the existence of 

any free program. We wish to make sure that a company cannot 

effectively restrict the users of a free program by obtaining a 
restrictive license from a patent holder. Therefore, we insist that 

any patent license obtained for a version of the library must be 
consistent with the full freedom of use specified in this license. 

 
Most GNU software, including some libraries, is covered by the 

ordinary GNU General Public License. This license, the GNU Lesser 

General Public License, applies to certain designated libraries, and 

is quite different from the ordinary General Public License. We use 
this license for certain libraries in order to permit linking those 

libraries into non-free programs. 

 
When a program is linked with a library, whether statically or using 

a shared library, the combination of the two is legally speaking a 

combined work, a derivative of the original library. The ordinary 

General Public License therefore permits such linking only if the 

entire combination fits its criteria of freedom. The Lesser General 

Public License permits more lax criteria for linking other code with 
the library. 

 
We call this license the "Lesser" General Public License because it 

does Less to protect the user's freedom than the ordinary General 

Public License. It also provides other free software developers Less 

of an advantage over competing non-free programs. These disadvantages 

are the reason we use the ordinary General Public License for many 

libraries. However, the Lesser license provides advantages in certain 

special circumstances. 

 
For example, on rare occasions, there may be a special need to 

encourage the widest possible use of a certain library, so that it becomes 

a de-facto standard. To achieve this, non-free programs must be 

allowed to use the library. A more frequent case is that a free 

library does the same job as widely used non-free libraries. In this 
case, there is little to gain by limiting the free library to free 

software only, so we use the Lesser General Public License. 

 
In other cases, permission to use a particular library in non-free 

programs enables a greater number of people to use a large body of 
free software. For example, permission to use the GNU C Library in 

non-free programs enables many more people to use the whole GNU 

operating system, as well as its variant, the GNU/Linux operating 
system. 

 
Although the Lesser General Public License is Less protective of the 

users' freedom, it does ensure that the user of a program that is 
linked with the Library has the freedom and the wherewithal to run 

that program using a modified version of the Library. 
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 The precise terms and conditions for copying, distribution and 

modification follow. Pay close attention to the difference between a 

"work based on the library" and a "work that uses the library". The 

former contains code derived from the library, whereas the latter must 
be combined with the library in order to run. 

libwebsockets GNU LESSER GENERAL PUBLIC LICENSE 
Version 2.1, February 1999 

 
Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 
[This is the first released version of the Lesser GPL. It also counts 
as the successor of the GNU Library Public License, version 2, hence 

the version number 2.1.] 

 

See above for details of the license. 

mtd Copyright © 2005 Waldemar Brodkorb <wbx@dass-it.de> 

Copyright (C) 2005-2009 Felix Fietkau < ndb@openwrt.org> 

 
# 

# Copyright (C) 2006-2009 OpenWrt.org 

# 
# This is free software, licensed under the GNU General Public License v2. 

# 

 

See above for details of the license. 

netsnmp Various copyrights apply to this package, listed in various separate parts 

below. Please make sure that you read all the parts. 

 
---- Part 1: CMU/UCD copyright notice: (BSD  like)  ----- 

Copyright 1989, 1991, 1992 by Carnegie Mellon University 

Derivative Work - 1996, 1998-2000 

 
Copyright 1996, 1998-2000 The Regents of the University of California 

 

 

All Rights Reserved 
 
Permission to use, copy, modify and distribute this software and its 
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 documentation for any purpose and without fee is hereby granted, 

provided that the above copyright notice appears in all copies and 

that both that copyright notice and this permission notice appear in 

supporting documentation, and that the name of CMU and The Regents of 

the University of California not be used in advertising or publicity 

pertaining to distribution of the software without specific written 

permission. 

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM 
ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT 
SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE 
LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR 
ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA 
OR PROFITS, WHETHER IN AN ACTION OFCONTRACT, NEGLIGENCE OR 
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH 
THE USE OR PERFORMANCE OF THIS SOFTWARE. 

 
---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) ----- 

 

 

Copyright (c) 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* Neither the name of the Networks Associates Technology, Inc nor the 

 
names of its contributors may be used to endorse or promote 
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 products derived from this software without specific prior written 

permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS ``ASIS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 
---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) ----- 

 
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.  

All rights reserved. 

Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* The name of Cambridge Broadband Ltd. may not be used to endorse or 

promote products derived from this software without specific prior 

written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ̀ `AS IS'' AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 

NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
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 HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 

 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ----- 

 

 

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, 

California 95054, U.S.A. All rights reserved. 

Use is subject to license terms below. 

 
This distribution may include materials developed by third parties. 

 
Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or  
registered trademarks of Sun Microsystems, Inc. in the U.S. and other 

countries. Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

 
* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* Neither the name of the Sun Microsystems, Inc. nor the 

names of its contributors may be used to endorse or promote 

products derived from this software without specific prior written 

permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO,THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL,EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
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 OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

 

---- Part 5: Sparta, Inc copyright notice (BSD) ----- 

Copyright (c) 2003-2012, Sparta, Inc 

All rights reserved. 

 
Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* Neither the name of Sparta, Inc nor the names of its contributors may 

be used to endorse or promote products derived from this software 

without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 
---- Part 6: Cisco/BUPTNIC copyright notice (BSD) ----- 

Copyright (c) 2004, Cisco, Inc and Information Network 

Center of Beijing University of Posts and Telecommunications. 

 
All rights reserved. 
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 Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

 

* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* Neither the name of Cisco, Inc, Beijing University of Posts and 

Telecommunications, nor the names of their contributors may 

be used to endorse or promote products derived from this software 
without specific prior written permission. 

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS ``ASIS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 

INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO,PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS;OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 
---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) ----- 

 

 

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 

oss@fabasoft.com 

Author: Bernhard Penz bernhard.penz@fabasoft.com Redistribution and use 

in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met: 

* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 
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 * Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* The name of Fabasoft R&D Software GmbH & Co KG or any of its 

subsidiaries, brand or product names may not be used to endorse or 

promote products derived from this software without specific prior written 

permission. 

 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ̀ `AS IS'' AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULARPURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVENIF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

 

---- Part 8: Apple Inc. copyright notice (BSD) ----- 

Copyright (c) 2007 Apple Inc. All rights reserved. 

Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions 

are met: 

1. Redistributions of source code must retain the above copyright 

notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above 

copyright notice, this list of conditions and the following 

disclaimer in the documentation and/or other materials provided 

with the distribution. 

3. Neither the name of Apple Inc. ("Apple") nor the names of its 

contributors may be used to endorse or promote products derived 

from this software without specific prior written permission. 
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THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE. 
 
---- Part 9: ScienceLogic, LLC copyright notice (BSD) ----- 

Copyright (c) 2009, ScienceLogic, LLC 

All rights reserved. 

 
Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are 

met: 

* Redistributions of source code must retain the above copyright notice, 

this list of conditions and the following disclaimer. 

* Redistributions in binary form must reproduce the above copyright 

notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

* Neither the name of ScienceLogic, LLC nor the names of its 

contributors may be used to endorse or promote products derived 

from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
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 CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE 

 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

rng-tools GNU GENERAL PUBLIC LICENSE 
Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 

See above for details of the license. 

strace Copyright (c) 1991, 1992 Paul Kranenburg <pk@cs.few.eur.nl> 

Copyright (c) 1993 Branko Lankester <branko@hacktic.nl> 

Copyright (c) 1993 Ulrich Pegelow <pegelow@moorea.uni-muenster.de> 

Copyright (c) 1995, 1996 Michael Elizabeth Chastain 

<mec@duracef.shout.net> 
Copyright (c) 1993, 1994, 1995, 1996 Rick Sladkey <jrs@world.std.com> 

Copyright (C) 1998-2001 Wichert Akkerman 

<wakkerma@deephackmode.org> 
All rights reserved. 

 
Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions 

are met: 
1. Redistributions of source code must retain the above copyright 

notice, this list of conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution. 

3. The name of the author may not be used to endorse or promote products 
derived from this software without specific prior written permission. 

 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY 

EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. 
IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
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 THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

stunnel Copyright (C) 1998-2014 Michal Trojnara 
 
This program is free software; you can redistribute it and/or modify it under 
the terms of the GNU General Public License as published by the Free 

Software 

Foundation; either version 2 of the License, or (at your option) any later 
version. 

 
This program is distributed in the hope that it will be useful, but WITHOUT 

ANY WARRANTY; without even the implied warranty of MERCHANTABILITY  
or FITNESS 

FOR A PARTICULAR PURPOSE. See the GNU General Public License for more 
details. 

 
You should have received a copy of the GNU General Public License along 

with 

this program; if not, see <http://www.gnu.org/licenses>. 

 
Linking stunnel statically or dynamically with other modules is making 

a combined work based on stunnel. Thus, the terms and conditions of the 

GNU General Public License cover the whole combination. 

 
In addition, as a special exception, the copyright holder of stunnel gives you 

permission to combine stunnel with free software programs or libraries that 
are released under the GNU LGPL and with code included in the standard 

release 

of OpenSSL under the OpenSSL License (or modified versions of such code, 
with 

unchanged license). You may copy and distribute such a system following 
the 

terms of the GNU GPL for stunnel and the licenses of the other code 

concerned. 

 
Note that people who make modified versions of stunnel are not obligated to 

grant this special exception for their modified versions; it is their choice 
whether to do so. The GNU General Public License gives permission to 

release a modified version without this exception; this exception also makes 

it possible to release a modified version which carries forward this exception. 
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tcpdump Copyright (c) 1991, 1992 Paul Kranenburg <pk@cs.few.eur.nl> 

Copyright (c) 1993 Branko Lankester <branko@hacktic.nl> 

Copyright (c) 1993 Ulrich Pegelow <pegelow@moorea.uni-muenster.de> 
Copyright (c) 1995, 1996 Michael Elizabeth Chastain 
<mec@duracef.shout.net> 

Copyright (c) 1993, 1994, 1995, 1996 Rick Sladkey <jrs@world.std.com> 

Copyright (C) 1998-2001 Wichert Akkerman 

<wakkerma@deephackmode.org> 

All rights reserved. 

 

See above for details of the license. 

uboot-tools GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

See above for details of the license. 

wireless_tools GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

See above for details of the license. 

linux GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

See above for details of the license. 
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libcli GNU LESSER GENERAL PUBLIC LICENSE 
Version 2.1, February 1999 

 
Copyright (C) 1991, 1999 Free Software Foundation, Inc. 
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 
[This is the first released version of the Lesser GPL. It also counts 
as the successor of the GNU Library Public License, version 2, hence 

the version number 2.1.] 

 

See above for details of the license. 

libscmd GNU LESSER GENERAL PUBLIC LICENSE 
Version 2.1, February 1999 

 
Copyright (C) 1991, 1999 Free Software Foundation, Inc. 

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

 
[This is the first released version of the Lesser GPL. It also counts 

as the successor of the GNU Library Public License, version 2, hence 

the version number 2.1.] 

 

See above for details of the license. 

angular The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 
Permission is hereby granted, free of charge, to any person obtaining a copy 

of this software and associated documentation files (the "Software"), to deal 

in the Software without restriction, including without limitation the rights 

to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 

copies of the Software, and to permit persons to whom the Software is 
furnished to do so, subject to the following conditions: 

 
The above copyright notice and this permission notice shall be included in 

all copies or substantial portions of the Software. 

 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER 
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 LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER 
DEALINGS IN 
THE SOFTWARE. 

angular-ui The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 

See above for details of the license. 

angular-ui- 
bootstrap 

The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 

See above for details of the license. 

angular-ui- 
grid 

The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 

See above for details of the license. 

bootstrap The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 

See above for details of the license. 

c3 The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 

See above for details of the license. 

jquery The MIT License 
 
Copyright (c) 2010-2015 Google, Inc. http://angularjs.org 

 

See above for details of the license. 
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 cambium_iprs 
t 

GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

 
Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

59 Temple Place, Suite 330, Boston, MA 02111-1307 USA 

Everyone is permitted to copy and distribute verbatim copies 

of this license document, but changing it is not allowed. 

See above for details of the license. 
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